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1 Organizer

Organizer is a daily tool for managing model information, object property
queries, and object classification. Using Organizer, you can access all model
information, including IFC information, in one place, and manage your model
information effectively. Organizer is an efficient tool at any stage in the
construction and design process for designers, detailers, managers,
estimators, contractors, or anybody using the model information.

For example, construction managers can view and report on key properties of
parts and groups of parts of the Tekla Structures model, such as the quantities
of purchasing packages. Designers can instantly check object, assembly, cast
unit, or pour unit properties during design to ensure that the properties are as
they are intended to be. For example, by creating categories it is easy to
automatically track precast or steel elements that are too heavy, reinforcing
bars that are too long, and status info.

You can synchronize Organizer with the model to get instant feedback on
what is changing in the model and create reports on demand.

Organizer consists of two tools:

• Use Object Browser to instantly view and create reports on model
information based on the selections you make.

• Use Categories to define building locations to automatically arrange model
objects and visualize the locations in the model. You can also create
categories based on different properties and write user-defined attributes
to objects based on the categories the objects belong to. You can use filters
to automatically update the category content whenever there are changes
in the model. You can also manually change the content of categories.

See also

View object properties in Organizer (page 8)

Report object property values from Organizer (page 20)

Create a property template in Organizer (page 24)

Create a color set in Organizer (page 32)

Import a property template to Organizer (page 33)

Organizer 7



Export a property template from Organizer (page 34)

Categories in Organizer (page 35)

Synchronize Organizer with the model (page 60)

Export a category from Organizer (page 64)

Import a category to Organizer (page 66)

Import IFC categories to Organizer (page 67)

Organizer in the multi-user mode (page 68)

Example: Organize the model into location and custom categories, and view
quantities (page 68)

Example: Track modeling and planning issues using Organizer (page 81)

Example: Add a classification code to objects in Organizer and export the code
to IFC (page 111)

Example: Create a custom category for structural design status in Organizer
(page 117)

Example: Create a custom category for architectural design status in Organizer
(page 118)

Example: Organizer for steel - manage bolts (page 121)

Example: Organizer for steel - manage assemblies (page 123)

Example: Organizer for precast (page 124)

1.1 View object properties in Organizer
You can view the properties of selected model objects in Object Browser.
Object Browser lists the objects that you have selected in the model or the
objects of the categories you have selected. The object properties are shown in
columns. You can change the order and sorting direction of the columns, and
group the properties to view the object data in a structured way.

Click Reload the view  in Object Browser when you want to view the latest
property values from the model. Once you have viewed a property of any
object, the property will be updated in the Organizer database at
synchronization.

NOTE Synchronizing Organizer  updates all properties of the changed
objects in the Organizer database. You do not need to reload Object
Browser if you change the selection in the model, or select another
category or another property template. When you have synchronized
Organizer, the object properties are up to date until you make
changes in the model.
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You can use Tekla Structures selection switches to select the needed objects in

the model, select assemblies , for example.

To view object properties in Organizer:

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Select model objects in the model, or a category in Categories.

3. Reload  Object Browser to show the latest object property values.

View the objects selected in the model or the objects of a
category

On the Object Browser toolbar, the automatic selection  is selected by
default. Object Browser automatically shows objects either from the model or
from the categories. If you have a category selected, Object Browser only
shows the objects that are in the category. If you have selected objects in the
model, Object Browser only shows these objects.

You can switch off the automatic selection if you want to control whether
objects are shown from the model or from the categories:

1. Click  to activate the other selection buttons.

2. Select the option you want to use: 

• Click  to show objects from the model.

• Click  to show objects from the categories.

Note that the objects of a selected category are by default not highlighted or
selected in the model.

To view the objects of a selected category in the model, select either Select
objects in the model or Highlight objects in the model from the list at the
bottom of the categories.

Set the limit for the number of objects shown in Object
Browser
Object Browser may not automatically show the objects you selected in the
model or in a category. There is a predefined limit for the number of objects
shown in Object Browser. If the number of objects you have selected is above
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the limit, Object Browser shows you how many objects you have selected and
what the limit for showing the objects is.

Do any of the following:

• Click  to show the objects.

Object Browser shows the objects and the object properties stored in the
Organizer database.

• Click  to reload the object properties and to show the objects.

Object Browser shows the objects and the object properties that have
been updated in the model.

• Change the predefined limit by entering a number in the box, for example

. Then click .

The number you enter in the box becomes the default limit for showing
objects in Object Browser.

• Make another selection.

You can also set the limit in Organizer Settings. Click  in the upper-right
corner of Organizer and go to the Synchronization tab.

View another property template
Select another template from the template list to view the same object
selection with a different template.

Set the default property template

1. Click  in the upper-right corner of Organizer to open the Settings.

2. Select a template from the property template list and click Set as default.
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3. Click Modify to save your selection.

The Set as default button is hidden when you have the default template
open. When you select another template, the button is shown again.

Pin the current template in Object Browser
Pinning a template holds the selected template visible in Object Browser.

When you pin a template and select different categories to view the model
objects in Object Browser, the pinned template is shown even if the selected
category has another template defined for it. This is useful if you want to
compare different categories using a certain template.

1. Click  to pin the current template in Object Browser. 

You can still select another template from the template list. Pinning always
keeps the latest selected template visible.

Click  to release the template.

Group object properties

1. Click  and select Group . 

Object Browser displays a grouping row.

2. Select a property column heading and drag the column to the grouping
row.

3. Click  and select Group  to hide the grouping row.

For more information, see Group object properties in Organizer (page 15).

Show assembly content

1. Click  and select Show content  to show the objects in the
assemblies, cast units, or pour units that are currently listed in Object
Browser. 

The assembly, cast unit, or pour unit hierarchy levels are shown in
different shades of blue.
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2. Click  and select Show content  to hide the assembly content. 

The assembly, cast unit, and pour unit hierarchy levels are also removed
when you sort and group objects in Object Browser. The objects shown
in Object Browser remain the same.

Combine identical rows
You can combine the rows that have the same property values in the Object
Browser view. When you combine the rows, Object Browser displays a Count
column that shows how many rows have been combined.

You can also select whether to show a single property value or the sum of the
property values in a column. The sum of the values is the single value
multiplied by the number of combined rows.

1. Click  and select Combine identical rows . 

Combined rows are shown even if you select another category in
Categories.

2. If needed, click Modify to include the combined rows in the property
template.

3. To show the sum of the property values in a column, click  in the
upper-right corner of Organizer to open the Settings , locate the
property under Columns and set the In combined row show option to
Result.

4. Click  and select  to remove the combined rows.

Show calculated results of object property values in the
sum row
1. Select whether Object Browser calculates the results from all or selected

rows. 

2. Select whether Object Browser shows the calculated total, average,
minimum or maximum values. 
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For more information, see Calculate property values in Organizer (page 18).

Use colors to visualize Object Browser groups in the model

1. Click  and select Group .

2. Select a property column heading and drag the column to the grouping
row.

3. Click  and point the Color set command. 

Object Browser lists the color sets that are available.

4. Click the Group command to select the current set, or select a suitable
color set from the sets that are available.

5. Click  and select a command other than Group to remove the colors.

Organizer assigns colors to the groups shown in Object Browser. The
topmost group in Object Browser gets the first color in the color set, the next
group gets the second color, and so on. The objects on the lowest group levels
are shown in the model using the assigned color.

For more information, see Create a color set in Organizer (page 32).

View categories, and unions and intersections of categories
1. Select more than one category in the category tree.

2. Click  and select any of the following: 

•  Automated is the default.

Automated shows the union of the object content of categories that
are under the same category root and the intersection of the object
content of categories that are in different category roots.

•  Separate categories shows the objects per category.

Automated adds the category structure to Object Browser.
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•
Union of categories

Object Browser shows the union of the object content of the selected
categories.

•
Intersection of categories

Object Browser shows the intersection of the object content of the
selected categories.

You can also click  at the bottom of Categories. The selection pane shows
either a union or an intersection of the selected categories, depending on
what you have selected. Drag categories between the boxes to modify the
unions and intersections.

When you view unions and intersections using the selection pane, ensure that

the Show the categories in Object Browser  button is not active.

List the categories of objects
1. Select one or more rows in Object Browser.

2. Right-click and select List the categories. 

The category list shows all the categories that contain at least one of the
selected objects.

3. Click a category in the list to highlight the category in Categories.

Hold the current view in Object Browser and remove
objects and categories from the view

1. Click  and select  to hold the current view. 

Your new selections in the model or in the categories are added to the
Object Browser view.

2. Remove objects and categories from the view: 

• To remove an object, right-click a row and select Remove from the
view.

• To remove a category, click  and select  Separate categories.
Right-click the category and select Remove from the view.

3. Click  and select  to release the view.
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Select the command buttons shown in Object Browser

1. Click  in the upper-right corner of Organizer to open the Settings.

2. Go to the Toolbar tab.

3. Select the buttons that you want to show on the Object Browser toolbar. 

4. Close the Settings dialog box.

Change the order of columns
Select a property column heading and drag it on the column heading row to
the desired location.

Change the sorting direction
1. Click a column heading to show the sorting direction. 

The default direction is ascending. You can change the default direction in

the Settings, click  in the upper-right corner of Organizer.

2. Click the column heading again to change the sorting direction.

See also

Set the units in Organizer (page 19)

Categories in Organizer (page 35)
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Group object properties in Organizer
You can sort the objects shown in Object Browser by grouping the objects
based on their properties. You can group object properties both in Object
Browser and in Organizer Settings. The grouping you define in Settings is
used in a property template when you save the template.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Select objects in the model or select a category to view the objects in
Object Browser.

3. Click  and select Group.

4. Drag one or more property columns to the grouping row. 

The objects are grouped according to the order of properties in the
grouping row, from left to right.

In the Organizer Settings, the grouping row is always available. To open

the Settings, click  in the upper-right corner of Organizer.

When you group object properties in the Settings, the grouping is
simultaneously shown in Object Browser if the grouping row is visible.

In the example below, the first grouping level is Name, the second level is
Material, and the third level is Profile.
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5. Do any of the following:

a. Drag the object properties in the grouping row to change the
grouping order.

b. Click an object property in the grouping row to change the sorting
direction.

c. Click Remove grouping  to remove an object property from the
grouping row. 

You can also drag the object property back to the column headings
row. When you drag the property, it is placed to the location where
you drag it to.

6. Click Modify to include the grouping to the template.

7. To permanently save the grouping to the template, save the Tekla
Structures model.

TIP When you have grouped objects in Object Browser, you can create a pie chart
to view the ratio of the number of the objects included in the groups. Press Alt +
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F12 to create the pie chart. You can copy the pie chart to any document by using
the Ctrl + C and Ctrl + V copy commands.

See also

Create a property template in Organizer (page 24)

View object properties in Organizer (page 8)

Calculate property values in Organizer
Object Browser shows the calculated total, average, minimum or maximum
object property values in a sum row. You can select which values are shown,
and whether the values are calculated from all the rows or from the rows you
have selected in Object Browser.

Click Reload the view  in Object Browser when you want to view the latest
property values from the model. Once you have viewed a property of any
object, the property will be updated in the Organizer database at
synchronization.

NOTE Synchronizing Organizer  updates all properties of the changed
objects in the Organizer database. You do not need to reload Object
Browser if you change the selection in the model, or select another
category or another property template. When you have synchronized
Organizer, the object properties are up to date until you make
changes in the model.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Select objects in the model or select a category to view the objects in
Object Browser.

3. Select whether Object Browser calculates the results from all or selected
rows. 

All is the default.

4. If you select Selected, select the rows in Object Browser.

5. Select a value option from the list: 
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The values are shown at the bottom in the sum row. The value is the
rounded result of the precise object property values.

NOTE By default, Object Browser shows the calculated values of properties for
which it is useful to calculate results. If you do not want to show the calculated

value of a property, click  in the upper-right corner of Organizer to open

the Settings and set the In sum row show option to - . Reload  the Object
Browser view.

See also

View object properties in Organizer (page 8)

Set the units in Organizer (page 19)

Set the units in Organizer
The default units in Tekla Structures depend on the settings in File --> Settings
--> Options --> Units and decimals . You can change these default settings in
Organizer to view a different unit system, unit type, and precision in Object
Browser and in Categories.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Click  in the upper-right corner of Organizer to open the Settings .

3. Go to the Units tab.

4. Select a unit system from the list.

5. Select a unit from the list.
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6. Select a precision from the list. 

Use the precision option for Others if you want to define the precision for
quantities other than distance, area, volume, or weight.

NOTE You can set the unit of an individual property column in Organizer Settings

 by clicking  in the column. These individual settings override the
Units tab settings. Individual settings are useful if you want to show the
length in imperial and metric units in one template, for example.

See also

View object properties in Organizer (page 8)

Calculate property values in Organizer (page 18)

1.2 Report object property values from Organizer
You can export object property values from Object Browser to Microsoft Excel
for further processing. The property columns in Object Browser are exported
exactly as they are shown. You can use predefined default Excel templates, or
you can create your own Excel templates for the export.

Ensure that you have Microsoft Excel installed on your computer.

If you want to create your own templates, first create a
\ProjectOrganizerData\ExcelTemplates folder under the current model
folder, project folder, firm folder or system folder, and save the templates
there. This way you can select your template from the list of available
templates in the Export data to Excel dialog box.

TIP • If you want to place the object properties to a certain location in the
Excel template, modify the template by typing %&O%& to the cell from
which you want data placement to start, and save the template.

• You can also define in the Excel template how the summary rows are
shown: either above or below the object rows. Go to the Data tab in
the Excel template, click the small arrow in the Outline area

, select the needed setting, and click OK. Then
save the template.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Select objects either in the model or in the categories to view the objects
and their properties in Object Browser.

3. Select a suitable property template.

4. Click  and select Export.
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5. Select an Excel template from the list of available templates, or click
Browse to select another template. 

If you do not select a template, a default Excel template is used in the
export.

Object Browser lists all the Excel templates that are available for the
export in the following folders:

• Current model folder

• Project folder (XS_PROJECT)

• Firm folder (XS_FIRM)

• System folder (XS_SYSTEM)

6. Select one or more export options: 

• Update object properties from the model is selected by default.

The latest object properties from the model are updated to Object
Browser for the export.

• Export without column headers

Select whether to export without the Object Browser column header
line.

This option is useful if you have predefined column headings in the
Excel template.

• Export only summary rows

Select whether to only export Object Browser summary rows.

7. Click Export. 

Microsoft Excel opens automatically. Grouping, combined rows, and
calculated values (total, average, minimum and maximum) are also
exported.

Example: Export project properties

You can automatically include any project property to the object property
export. You can do this by creating a separate property template for the
project properties and naming it as W_Project_data.

NOTE You must use W_Project_data as the name of this template.

1. Define the project properties in File --> Project properties . In this
example, you enter the project name, project builder, and a project
comment in the user-defined attributes.
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2. In Organizer, create a property template (page 24) for the project
properties you defined above. In this example, you only add the project
properties to the template.

You can add any properties in the template. Note however that Organizer
will add to the report the first random value that it finds for the property.
Therefore, add in the template only such properties that have the same
value for all objects. For example, you can add PHASE to the template if all
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the objects you intend to include in the report are going to belong to the
same phase.

a. Click  in the upper-right corner of Organizer to open the Settings
and click Template.

b. Name the template as W_Project_data and select Blank template.

c. Click Create.

d. Drag the PROJECT.NAME, PROJECT.BUILDER and 
PROJECT.USERDEFINED.PROJECT_COMMENT project properties to
the property columns.

e. Click Modify to save the template.

3. Add the project properties to the Excel template that you are going to use
in the export and save the template.

You can copy the column headers from the property template and add
them anywhere in the Excel template, see an example below.

NOTE If you add a DATE type of property to the Excel, change the format
of the Excel cell to Date to show the date correctly. A DATE type of
property is a property that has DATE in the name.
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NOTE If you want to add the DATE property to your property template to
add the current date, you have to change the name of the column
header to be something different than DATE. For example, change
it to DATE1, and use the same text (DATE1) in the Excel template.

4. Export object properties and project properties from Organizer.

a. Select objects in the model or categories to view the objects in Object
Browser.

b. Select a property template that you want to use in the export, for
example, Default or Rebar.

c. Click  and select Export.

d. Select the Excel template you modified previously and click Export.

The values of the project properties that you added to the Excel template
are shown in the exported Excel.

See also

Export a property template from Organizer (page 34)

1.3 Create a property template in Organizer
You can create property templates in Organizer to view the properties of
selected model objects in Object Browser. For example, you can create
templates for different object types and object groups, and include the needed
object properties in the template. You can group and sort the properties in the
template. You can also modify existing templates.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Click  in the upper-right corner of Organizer to open the Settings.
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3. If you want to create the new property template based on a current
template, select the template from the list of templates. 

You can modify an existing template by selecting it from the list of
templates and changing the properties included in it.

4. Click .

5. Enter a unique name for the property template. 

Create is dimmed if you enter the name of an existing template.

6. Select whether the template is created based on the current template or
as a blank template.

7. Click Create. 

Property templates are saved to the ProjOrg database in the
\ProjectOrganizer folder in the model folder. The saved property
templates are shown in the property template list.

8. Do any of the following to define the properties that are included in the
template: 
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Option in
image

Description

1 Create a new property column.
2 Enter a name for a new property column or rename a property

column.
3 Drag one or more object properties from the list of properties to

a property column.

The properties are read from the environment.db file in the
model folder.

If you need properties that are not available in the list, for
example reference model object properties, you can create them
in Organizer as custom properties (page 28).
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Option in
image

Description

You can use the search box to easily find the relevant properties.

In the Group list, you can select an option to show only certain
properties, for example:

• Select Recent to view the most recently used and created
properties.

• Select Custom to view imported properties and the
properties you have created in Organizer.

• Select Property templates to view the properties that are
used in the property templates of your model.

4 Click Ascending or Descending to change the sorting order in a
property column.

5 Drag a property column to the grouping row. The grouping icon
 is shown in the property column.

6 Delete a property column.
7 Select the property value shown in the sum row in Object

Browser:

• - (minus) does not show any value.

• Single value shows a single property value. The single value
is shown if all the objects have the same property value in the
column.

• Result shows the sum of all the property values in the
column.

8 Select the property values shown in combined rows in Object
Browser:

• Single value shows a single property value.

• Result shows the sum of the property values.

9 Click  to set the unit and the precision of the unit for a
property column.

10 Select a color set (page 32) for the template.

9. Click Modify to save the properties to the template.

10. To permanently save the template and the changes you have made to it,
save the Tekla Structures model. 

TIP You can save the property templates to a \ProjectOrganizerData
system folder to make them automatically available in all models.
For information on how to use the firm, project and system folders
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with Organizer, see Customized default setup for Organizer
(page 57).

Example of using multiple object properties

It can be useful to have multiple object properties in one column. This way you
can ensure that the relevant property value is found for different object types.

For example, you can include different name properties in the Name column.
Object Browser shows NAME for parts, ASSEMBLY_NAME for assemblies, 
CAST_UNIT_NAME for cast units, and so on.

When searching for the properties, Object Browser uses the order, from left
to right, in which the properties are shown in the column. Once a value is
found, the rest of the properties in the column are ignored.

See also

Create a custom formula in Organizer (page 30)

Create a custom property in Organizer
You can create your own properties in Organizer and use these properties in
property columns in the same way as any other properties. If you want to use
the properties in the model, you can add them to the model objects in
property categories.

Some object properties, for example, the properties of reference model
objects are not automatically available in Organizer. To use these properties
in Organizer, create them as custom properties.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Click  in the upper-right corner of Organizer to open the Settings .

3. Click Custom.

4. Select Property.
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5. Enter a name for the property in the Name box. 

This name is shown in the list of properties. Ensure that there are no
space characters before or after the name.

6. Enter the exact name of the property in the Property box. 

Organizer uses this name to search for the property value. Ensure that
there are no space characters before or after the name. For UDA type
properties, the maximum length is 19 characters.

NOTE For reference model object properties you must add EXTERNAL.
at the beginning of the property name, for example, 
EXTERNAL.Tekla Reinforcement.Rebar Mark. You can copy
the exact name of the property from the Inquire object dialog
box, for example.

7. Select a unit type for the property. 

Organizer automatically selects the default Data type value of the unit
type. You can change the data type.

8. Select a data type for the property.

9. Select a property type for the property. 

Use UDA when creating properties that you write to the model.

10. Click OK.

Custom properties are shown in the list of properties in the Custom group.
UDA properties are also shown in the UDA group. You can modify and delete
custom properties by right-clicking the property.

See also

Create a property template in Organizer (page 24)
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Create a custom formula in Organizer
You can create simple mathematical formulas using the object properties that
are available in Organizer. You can, for example, calculate areas of specific
object types. You can add formulas to property columns in the same way as
object properties. You can also use formulas in the object properties when
creating property categories.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Click  in the upper-right corner of Organizer to open the Settings .

3. Click Custom.

4. Select Formula.

5. Enter a name for the formula. 

Ensure that there are no space characters before or after the name.

6. Enter a property name in the search box in the Settings dialog box to find
a property. 

You can also select an option from the Group list to narrow down the
selection of properties shown in the list of properties.

7. Drag the needed properties to the formula box in the Create Formula
dialog box.

8. Drag the needed mathematical operators to the formula box and place
them between the properties. 

•  to add the main mathematical operation signs.

•  to add parentheses.

•  to add a box where you can enter a number.
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9. If needed, drag the properties and operators inside the formula box to
modify the formula. 

Organizer automatically checks whether the formula is mathematically
correct. If the formula is not correct, Create is dimmed and the incorrect
parts are shown in red.

10. Select a unit type that is suitable for the properties used in the formula.

11. Click Create.

The formula is shown in the list of properties in the Custom group. You can
modify and delete custom formulas by right-clicking the formulas in the list of
properties. You can use custom formulas in property templates by dragging
the formulas to property columns.
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See also

Create a property template in Organizer (page 24)

Create a color set in Organizer
You can use colors to visualize the content of Object Browser groups in the
model. The colors are included in color sets that you can create and modify.
You can include a color set in a property template so that a property template
always uses certain colors. The color visualization is for viewing purposes. You
cannot save the colors in the model or in Object Browser.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Click  in the upper-right corner of Organizer to open the Settings.

3. Go to the Colors tab.

4. Click . 

The color set is created based on the set that is currently selected.

5. Enter a unique name for the color set.

6. Click Create.

7. Do any of the following to define the colors that are included in the color
set: 

• Double-click a color to modify it.

• Drag the colors to arrange them to a different order.

The colors are used in Object Browser in the order in which they are
listed in the color set. The topmost group in Object Browser gets the
first color, the next group gets the second color, and so on.

• Right-click a color and select to add, delete, cut or copy the color.

• Double-click an added color to modify it.

You can select multiple colors by using the Ctrl and Shift keys.

• Click Reset colors to restore the colors of the Default set.

8. If needed, click Set as default to use the color set as the default set in
Organizer.

9. Click Modify. 

Organizer keeps the settings you have defined in the new color set. If you
do not click Modify and close the Settings dialog box, the new color set
has the same settings as the color set you used as a basis for the new set.
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TIP You can export color sets from Organizer in the xml format and use the sets in
other models. You can export one set at a time. The color set file has
the .colorset file extension.

You can import color sets that have been exported from the current model or
other Tekla Structures models as in the xml format. You can import several files
at a time.

See also

Create a property template in Organizer (page 24)

View object properties in Organizer (page 8)

Delete a property template in Organizer
You can delete property templates in Organizer Settings.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Click  in the upper-right corner of Organizer to open the Settings .

3. Select a property template from the list of templates.

4. Click  to delete the selected property template.

See also

Create a property template in Organizer (page 24)

1.4 Import a property template to Organizer
You can import to Organizer property templates that have been exported
from the current model or other Tekla Structures models. Property templates
are in the xml format. You can import one or multiple templates at a time.

You can save the property templates to a \ProjectOrganizerData system
folder to make them automatically available in all models. For information on
how to use the firm, project and system folders with Organizer, see
Customized default setup for Organizer (page 57).

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Click  in the upper-right corner of Organizer to open the Settings .

3. Click Import.

4. Select the property template file you want to import. 

Property template files have the .propertytemplate file extension.
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5. Click Open. 

The file is imported and shown in the property template list in Organizer.
If an existing template has the same name as the imported file, Organizer
adds a running number to the name of the imported file.

Organizer displays an error message if the selected file is not a valid property
template file and does not import the file.

If the imported template contains properties that are not in the list of
properties in Organizer, these properties are added as custom properties.

See also

Export a property template from Organizer (page 34)

1.5 Export a property template from Organizer
You can export property templates from Organizer to xml format files and
use the exported templates in other models. You can export one or multiple
templates at a time. Exporting the templates also ensures that you have back-
up copies of the templates you have created.

For information on how to use the firm, project and system folders with
Organizer, see Customized default setup for Organizer (page 57).

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Click  in the upper-right corner of Organizer to open the Settings .

3. If you want to export a specific property template, select the template
from the list of templates.

4. Click Export.

5. Select whether to export the current property template or all property
templates.

6. Click Browse to select the destination folder. 

By default, the templates are exported to the \ProjectOrganizer folder
in the current model folder.

7. Click Export.

Each exported template creates a separate xml format file. The file extension
is .propertytemplate.

See also

Report object property values from Organizer (page 20)

Import a property template to Organizer (page 33)
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1.6 Categories in Organizer
You can categorize your model in location categories and other type of
categories that you can create based on your needs using for example object
properties.

• Using location categories, you can create a location breakdown structure
and divide the model into projects, sites, buildings, sections and floors. A
project contains all the objects of the models that are selected in the
category properties, either the Tekla Structures model or reference models,
or both. Within a project, a model object can belong to only one lowest
level location category at a time.

Data related to location categories (for example, floor, building) is only
written to the highest level assemblies. For example, a precast cast unit
inside the first floor will receive Floor 1 as a property, but the rebars in
the cast unit will not.

Organizer always creates an uncategorized category in a project for
objects that cannot be included in any other category based on the location
definitions you have made. You can modify the definitions to include the
objects to location categories.

• Property categories allow you to add user-defined attributes (UDA) to
model objects. Within a property category, a model object can belong to
only one lowest level category at a time.

• Custom categories are created based on the rules that you define. Objects
are added to the categories based on these rules. You can also create
categories manually without rules.

NOTE You can define whether Organizer uses pour units or cast-in-place cast units
as the highest cast-in-place hierarchy level in the categories. To do this, click

 in the upper-right corner of Organizer to open the Settings, and go to
the Synchronization tab. Select Pour units enabled to use pour units.

Organizer is fully synchronized when you close the Settings dialog box.

An example of a default category set in Organizer:
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When you have included objects in the categories:

• The number of objects in a category is shown in parentheses for location
categories and property categories, and for lowest level custom categories.

• The number of objects in a category and the total number of objects
included in the category and its subcategories is shown in parentheses for
custom categories, as shown in the image below.
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See also

Create location categories in Organizer (page 37)

Create location categories manually in Organizer (page 42)

Create a property category in Organizer (page 43)

Create a custom category in Organizer (page 47)

Create automated subcategories in Organizer (page 50)

Modify a category in Organizer (page 52)

Delete a category in Organizer (page 57)

Customized default setup for Organizer (page 57)

Excluding object types from Organizer (page 59)

Create location categories in Organizer
You can create location categories by defining boundary boxes for the
categories. This functionality allows you to organize model objects to sections
and floors. The objects are automatically updated to categories based on their
locations and the defined boundaries. If an object is not inside or within the
limits of a boundary box, it will be placed in an uncategorized category that is
automatically created.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Select Building in the category tree.

3. Right-click and select Define boundary boxes for locations.

4. On the Building tab, define the boundary box for the building.

a. If there are several grids in the model, select a grid for this building
from the Grid origin in the model list. 

The grid selection is available only if there are several grids.

The grid selection shows the global x, y and z coordinates of the grid
origins and the rotation of grids compared to the model origin
coordinates.

When you have selected a grid for a building, we recommend that
you do not make changes to the grid in the model. But if you do,
remember to manually update the grid coordinates here in this dialog
box, too.

b. If needed, change the default name of the building.

c. Define the x, y and z coordinates for the building boundary box by
selecting the boundary coordinates from the list, or by entering
suitable coordinates in the boundary coordinate boxes.
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d. Click the  icon in front of the building to view the boundary box in
the model. 

The image below shows an example of building coordinates.

e. Right-click in the model and select Update window to remove the
boundary box from the model view.

5. On the Sections tab, define the boundary boxes for sections.

a. Click  to create one or more sections.

b. If needed, change the default names of the sections.

c. Define the x, y and z coordinates for the section boundary box by
selecting the boundary coordinates from the list, or by entering
suitable coordinates in the boundary coordinate boxes. 

Ensure that the sections do not overlap and that they are inside the
building boundary box. A red exclamation mark is shown in front of
the coordinates if the boundary boxes overlap. You can save the
location definitions when the boundary boxes do not overlap.

d. Click the  icon in front of the section to view the boundary box in
the model. 
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The image below shows an example of section coordinates.

e. Right-click in the model and select Update window to remove the
boundary box from the model view.

6. On the Floors tab, define the boundary boxes for floors.

a. Click the Floor system button. 

You can add as many floor systems as you need. The added floor
systems are available in the list.

b. If needed, enter a name for the floor system.

c. Do one of the following: 

• Click  to add a top floor to the floor system.

You can enter the height of the top floor in the box next to the
button.

• Click  to create floors automatically based on
the grid levels.

d. If needed, change the default names of the floors.

e. Define the z coordinates for the floors by selecting the boundary
coordinates from the list, or by entering suitable coordinates in the
boundary coordinate boxes.

f. Select a building or a section in which the floor system is used from
the list in the box at the top right. 
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If you have not defined sections, the buildings are shown. The
building or section is added to the box.

Floor systems can be used in several buildings and sections. If the
floor system is used in some other building and you want to remove
the floor system from that other building, you need to open the
boundary box definitions of that other building and make the
modifications there.

g. Click the  icon in front of the floor to view the boundary box in the
model. 

The image below shows an example of floor coordinates.

h. Right-click in the model and select Update window to remove the
boundary box from the model view.

7. On the Settings tab, define how objects are placed in the categories. 
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Organizer checks the selected options in the order in which they are
shown on the Settings tab, from top to bottom.

The objects that cannot be included in categories based on the default
and the selected optional settings are placed in an Uncategorized
category that is created automatically on the relevant level. You can either
modify the boundary coordinates or manually move the objects to the
correct location.

Note that if you have more than one project, you cannot move objects
from one project to another.

8. Click Modify and Close.

9. Right-click any category in the project and select Synchronize category to
refresh the category content from the model. 

You can also click  to synchronize Organizer.
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When you have created the categories, the icons in front of the categories are
shown as blue in the category tree.

Copy a project to property categories or custom categories

You can copy any Project from the location categories to the property
categories or custom categories.

1. Select the Project that you want to copy.

2. Drag the Project to the property categories or custom categories in the
category tree.

Organizer shows a thick line in the location to which you can copy the
Project.

3. Select the appropriate copy option:

• Copy to copy the Project tree structure and the objects

When you copy a Project using this option and later make changes in
the Project in the location categories, the changes are automatically
shown in the copied Project.

• Copy only the tree structure to copy the Project tree structure

NOTE If you select a Tekla Structures model in the category properties, all
assemblies, cast units, or pour units are included.

If you select any of the reference models in the category properties,
the reference assemblies or reference objects are included. If there
are no assemblies in a reference model, then the reference objects are
included.

See also

Categories in Organizer (page 35)

Modify a category in Organizer (page 52)

Delete a category in Organizer (page 57)

Create location categories manually in Organizer
You can manually create location categories without defining boundary boxes
for the categories.

1. To open Organizer, click Manage on the ribbon and then click Organizer.
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2. Select a Project, right-click and select New site. 

You can also select New project to have Organizer automatically create
Site and Building under the project.

3. Right-click the Site you created and select New building.

4. Right-click the Building you created and select New section or New
floor.

5. Right-click the Section you created and select New floor. 

You can create as many projects, sites, buildings, sections, and floors as
you need.

6. Add objects to the categories. Do one of the following: 

• Select a category in the project to show the model objects in Object
Browser and select the objects that you want to move to the new
category. Then drag the objects to the new category.

• In the model, select the objects that you want to move, right-click the
new category and select Move the selected objects.

NOTE You cannot move objects from one project to another. Within a
project, you can move model objects between the lowest level
categories. One object can belong to only one lowest level
location category at a time.

When you have created the categories manually, the icons in front of the
categories are shown as black in the category tree.

See also

Categories in Organizer (page 35)

Modify a category in Organizer (page 52)

Delete a category in Organizer (page 57)

Create a property category in Organizer
You can create property categories to add properties to model objects. You
can use existing user-defined attributes (UDAs) in the categories and add

Organizer 43 Categories in Organizer



values to them, or you can create UDAs as custom properties in Organizer
and use these in the property categories.

NOTE If you have several property categories, you can use a certain UDA in
only one root level property category. This ensures that other
categories do not overwrite the UDA.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. In Categories, select a property category at the root category level, right-
click and select Properties. 

3. Add content to the category (page 47). Properties are added to the
objects that are in the category. 

You can do the following:

a. Add the category content manually (page 52) by selecting objects in
the model and inserting them to the category, or by defining rules
that automatically insert objects to the category.
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b. Add subcategories (page 50) to the category. Subcategories can be
added manually or automatically based on a property. The property
values are written to objects from lowest level categories.

c. Select the Do not delete empty automated subcategories check
box to keep all subcategories at synchronization. If you do not select
the check box and change the model so that some, or all of the
subcategories do not contain any objects, the empty subcategories
are deleted when you synchronize the root category or the whole
Organizer.

d. Select the Include the highest assembly level in the model option
if you want to ensure that only highest level assembly objects are
inserted to the category. Organizer shows either cast-in-place cast
units or pour units at the highest cast-in-place hierachy level,
depending on whether you have selected the Pour units enabled

setting in Organizer Settings  > Synchronization.

4. Under Object properties, select a custom property or an existing UDA.
You can add more than one property.

5. Define the property settings: 

a. Select the value type from the Type list and define the value in the
Value box. 

The type determines what kind of values you can use.

Typ
e of
UDA

Type Value

Strin
g

Text Enter text or a number.
Category name Organizer adds the name of the category to the

Value box automatically.
Combined category
names

Organizer adds the names of the categories to
the Value box automatically.

Inte
ger

Number without
decimals

Enter a number.

Dou
ble

Number with
decimals

Enter a number with decimals.

Formula Select a formula from the Value list. Formulas
are defined in Organizer Settings.
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Typ
e of
UDA

Type Value

Date Date Enter a date or select it from the calendar.

b. Select a unit for the value from the Unit list. 

Only the possible unit options are available for the property:

• The units of the properties are defined in
contentattributes_userdefined.lst or object.inp files.

• The units of custom properties that are created in Organizer are
defined when creating the property.

c. Modify the properties in the subcategories if you want the
subcategories to have different property values for the same
property. 

• If you want a property to use the property value defined on the
higher property category level, select the Inherit value check box
after the property name.

• If you have selected the Inherit value check box but select a type
in the Type box or enter a value in the Value box, the Inherit
value check box is cleared automatically.

NOTE The property values are written to the objects from the
lowest level subcategories.

When you write the custom properties you have created in
Organizer to the model, you can use these properties as any
other UDAs in the model.

When the properties are written to the model, you can use them in
visualization and IFC export, for example. You can also view the
properties in object dialog boxes and share them with Tekla Model
Sharing.

6. Clear the Update category at synchronization check box if you do not
want to update the category when you synchronize the whole Organizer
with the model.

7. Click Modify. 

Organizer creates an Uncategorized category for the objects that are not
included to the lowest level categories yet. If the same objects would
belong to more than one subcategory based on the category rules,
Organizer creates a Clashing category for these objects. You need to
modify the category rules to empty the Clashing category.

8. Click  to synchronize Organizer, or select any category in the property
category tree, right-click and select Synchronize category. 
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Properties and their values are written to the model objects when
Organizer or the category is synchronized. Uncategorized and Clashing
categories do not modify the existing UDA values.

You can inquire the properties written to the model and report (page 176)
them as any other properties.

NOTE If you delete a property category and its subcategories, the properties that
have already been written to the model are not removed.

UDAs with options

If you add UDAs with options to a property category when writing properties
to the objects, you have to use the UDA - <property name> format.

To get the correct report result in Object Browser, you can use the same
property without UDA - in the name.

See also

Categories in Organizer (page 35)

Example: Organizer for precast (page 124)

Create a custom category in Organizer
You can create custom categories to group model objects, for example, based
on object properties.

1. To open Organizer, click Manage on the ribbon and then click Organizer.
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2. Click  to create a new category. 

If you have a category selected, the new category is created on the same
level as the selected category. If you have several categories selected or
do not have any category selected, the new category is created at the root
category level. You can add as many categories as you need.

3. Right-click the new category and select Properties.

4. Type a name for the category.

5. Define the rules for setting the category content:

a. Under Automated object content, select the models, filters and
categories that are used to automatically add objects to the category.
Do any of the following: 

• Click the Select model list and select a model to add its objects to
the category.

To include all model objects in the category, select the Tekla
Structures model.

• Drag a category from the category tree to the categories and
filters rule box, or click or type in the box and select a filter from
the list.

• Click Object group to define a filter for Organizer.

The Object Group - Organizer dialog box opens in the Tekla
Structures main view. When you have saved the filter, click or type
in the rule box again and select the filter.

Organizer filters are saved in the \attributes folder of the
model folder with the .OrgObjGrp file extension. You can use
these filters only in Organizer.

You can add as many filters and categories as you want to the same
rule box.

If you add more than one category or filter to the same rule box, the
category content is a union of all the objects in them.

If you add categories or filters to separate rule boxes, select whether
the category content is an intersection or difference of the content of
the boxes.

NOTE You can also separately create filters for Organizer before
creating any categories. These filters are created in the same
way as Tekla Structures selection and view filters, and you can
use them in category rules. When creating the filters, click

 in the filter settings and set Organizer as the filter type.
Then define the settings needed in the filter.
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b. Under Automated subcategories, select the properties that are
used to create the subcategories. Do the following: 

• Click Grouping in Object Browser.

To use this option, drag one or more property columns to the
grouping (page 15) row in Object Browser. Organizer uses the
properties included in the columns when creating the
subcategories.

You can also add property template columns or object properties
to the rule boxes.

• Click the rule boxes and select a property template column or an
object property.

Note that you cannot use the Grouping in Object Browser option
if you first add property template columns or object properties to
the rule boxes.

You can add more than one column or property to the same rule
box.

Organizer adds a new subcategory level to the properties dialog
box when you have added a column or a property to the rule box.
If you want the category to have the new subcategory level, add
columns or properties to the rule boxes on the new subcategory
level.

• Select the Do not delete empty automated subcategories check
box to keep all subcategories at synchronization.

If you do not select the check box and change the model so that
some, or all of the subcategories do not contain any objects, the
empty subcategories are deleted when you synchronize the root
category or the whole Organizer.

c. Select the Include the highest assembly level in the model option
if you want to ensure that you have only assembly level objects in the
category. 

When you select this option and add a model object to the category,
the assembly to which the object belongs will be added to the
category.

Organizer shows either cast-in-place cast units or pour units at the
highest cast-in-place hierachy level, depending on whether you have

selected the Pour units enabled setting in Organizer Settings  >
Synchronization.

6. Clear the Update category at synchronization check box if you do not
want to update the category when you synchronize Organizer with the
model.
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7. Select a default property template for the category from the Property
template list. 

This is the property template that is shown in the Object Browser
property table.

8. Click Modify .

TIP You can manually add categories and subcategories to automated categories.
Select a category, right-click and select New category or New subcategory.
Manually added categories are not deleted at synchronization. When you
synchronize a manually created subcategory, only that category is synchronized.

See also

Customized default setup for Organizer (page 57)

Categories in Organizer (page 35)

Modify a category in Organizer (page 52)

Delete a category in Organizer (page 57)

Create automated subcategories in Organizer
You can create an automated subcategory tree structure for one or several
custom categories at a time. The categories for which you create the
automated subcategories cannot already have subcategories. If you use an
empty category that does not contain objects yet, only the category rules are
saved.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Select a custom category, right-click and select Create automated
subcategories. 

Organizer opens the Automated subcategories section in the category
properties dialog box.

3. Do the following to select the properties that are used to create the
subcategories: 

• Click Grouping in Object Browser.

To use this option, drag one or more property columns to the grouping
(page 15) row in Object Browser. Organizer uses the properties
included in the column when creating the subcategories, for example,
as shown in the image below.

Organizer 50 Categories in Organizer



You can also add property template columns or object properties to
the rule boxes.

• Click the rule boxes and select a property template column or an
object property.

Note that you cannot use the Grouping in Object Browser option if
you first add property template columns or object properties to the
rule boxes.

You can also type the name of the property in the box, for example, 
PROFILE and press Enter. You can add more than one column or
property to the same rule box.

Organizer adds a new subcategory level to the properties dialog box
when you have added a column or a property to the rule box.

4. If you want the category to have the new subcategory level, add columns
or properties to the rule boxes on the new subcategory level.

5. Select the Do not delete empty automated subcategories check box to
keep all subcategories at synchronization. 

If you do not select the check box and change the model so that some, or
all of the subcategories do not contain any objects, the empty
subcategories are deleted when you synchronize the root category or the
whole Organizer.

6. Click Modify.

TIP You can manually add categories and subcategories to automated categories.
Select a category, right-click and select New category or New subcategory.
Manually added categories are not deleted at synchronization. When you
synchronize a manually created subcategory, only that category is synchronized.

See also

Categories in Organizer (page 35)
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Create a custom category in Organizer (page 47)

Modify a category in Organizer (page 52)

Delete a category in Organizer (page 57)

Modify a category in Organizer
You can modify the category rules and make manual changes to the category
content.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Do any of the following:

To Do this
Rename a category Select a category, right-click and select Rename.
Show cast-in-place
cast units or pour
units as the highest
cast-in-place hierarchy
level

1.
Click  to open Organizer Settings.

2. Go to the Synchronization tab.

3. Select or clear the Pour units enabled check box,
depending on what you want to show in the
categories.

Note that when you select or clear the Pour units
enabled setting, Organizer will be fully synchronized
when you close the Settings dialog box. Take this
into account when changing the setting in large
models, as synchronization may take some time.

Categories with manually added objects will lose the
pour unit or cast-in-place cast unit content,
depending on what you have selected.

4. Close the Settings dialog box.
Add objects to a
category

You can manually add objects to a category.

1. Select objects in the model or select a category.

2. Select objects in Object Browser by selecting rows.

3. Drag the selected objects to a category.

If you want to add all the objects that you have selected
in the model, you can also right-click the category and
select Add the selected objects.

Click  to hold the view in Object Browser. When you
hold the view, you can make selections in the model or in
the categories without changing the contents shown in
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To Do this
Object Browser. To show objects per category in Object

Browser, click  and select  Separate categories.

In location categories, when you select objects in one
category and add them to another category, the objects
are moved to the other category. An object can be in only
one lowest level location category within a project.

Remove objects from
a category

You can manually remove objects from a category.

1. Select a category.

2. Select the objects in Object Browser.

3. Right-click and select Remove the selected objects
from the selected categories.

Manage manual
changes in a category

You can view in Object Browser how each object has
been included in the category, or why it is not included.
Objects can be included in categories either automatically
based on category rules, or you can add and remove
them manually.

1. Select a custom category.

2. Right-click the category and select Properties to view
the rules used in the category.

The properties show whether there are manually
added and removed objects in the category. You can
control the status of the objects in Object Browser.

3.
Click  and select  Manage manual changes.

Organizer places a purple frame around Object
Browser and Categories, and adds a Status column
to Object Browser. In the manual change mode, a
limited set of Organizer commands is available.

Each object has a status icon:

•

The object has been automatically added to the
category based on the category rules.

•

The object has been automatically added and
manually removed from the category.

•

The object has been automatically added to the
category and manually added to the category.
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To Do this
•

The object has been manually added to the
category.

•

The object has been manually removed from the
category.

Note that the status applies in the selected category.
The object may have a different status in another
category.

4. Right-click an object in Object Browser to change
the status:

• Add manually adds the object to the category.

• Remove manually removes the object from the
category.

• Remove manual changes removes manual
status from an object but leaves the object to the
category if it has been included automatically.

Modify category rules 1. Select a category, right-click and select Properties.

2. Modify the category content rules under Automated
object content.

The  icon in the Automated object content
button shows that the category has automated
object content rules defined.

Do any of the following:

• Select a model from the list of models.

Click Model list to see which models are already
used in the rules.

• Drag a category from the category tree to the rule
box.

• Click or type in the rule box and select a filter
from the list.

• Click Object group to define a filter for
Organizer. When you have saved the filter, click
or type in the box again, and select the filter.

You can add more than one category and filter,
and create unions, intersections, or differences of
them.
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To Do this
3. Modify the subcategory rules under Automated

subcategories.

The  icon in the Automated subcategories
button shows that the category has automated
subcategory rules defined.

Do any of the following:

• Click the rule boxes to add more property
template columns or properties to the rules.

You can add more properties to the existing
subcategory hierarchy levels or to the empty
hierarchy level that is under the existing levels.

• Remove a property from the rules.

• Remove a whole subcategory hierarchy level from
the rules.

4. Click Modify.

You can modify the subcategory rules of several
subcategories at the same time if they have the same
subcategory rules, see also Create automated
subcategories in Organizer (page 50).

Change the default
property template of a
category

1. Select a category, right-click and select Properties.

2. Select another property template from the Property
template list.

3. Click Modify.
Modify the properties
of multiple categories

1. Select the categories you want to modify.

2. Right-click and select Properties.

The properties you can modify depend on the selected
categories. You can, for example, change the default
property template or subcategory rules.

Change the category
content to include the
highest assembly level

1. Select a category, right-click and select Properties.

2. Select theInclude the highest assembly level in
the model check box.

3. Click Modify.

If you add parts to a category that includes only
assemblies, the assembly information is shown in the
category.

Modify the boundary
boxes of a building,
section or floor
category

1. Select a category that you have created using
boundary boxes.

2. Right-click and select Define boundary boxes for
locations.
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To Do this
3. Modify the boundary box definitions.

If you modify a building coordinate and a section has
the same coordinate, the section coordinate changes
to the modified building coordinate.

The categories you have created using boundary boxes
have a blue icon in the category tree.

Add a floor manually
to a building that has
an automated location
breakdown structure

You can manually add floors to automated buildings, for
example, to collect the objects of special structures within
a building into separate categories. The manually added
floors do not have a boundary box for automated object
collection. You can add objects from any part of the
building.

You can use the manual floor category, for example, to
separate the elevator shaft from the rest of the building.

1. Select a section under a building that has an
automated location breakdown structure.

2. Right-click and select New floor.

3. Add objects to the floor.

4. Select the Project root category, right-click and select
Write to the model for reporting to write the new
location information to the model objects.

Add a category
manually to an
automated category

You can manually add categories to automated
categories. Manually added categories are not deleted at
synchronization even if they do not contain any objects.

1. Select an automated category.

2. Right-click and select either New category or New
subcategory.

Copy or move a
category

You can copy or move one category and its subcategories
at a time.

1. Select a category and drag it to a suitable location in
the category tree, either on top of a category or
between two categories.

2. Select a suitable option from the list:

• Copycopies the category properties and the
objects in the categories to the target category.

• Copy only the tree structure copies the tree
structure without the objects and their
properties.

• Move moves the category with the objects and
their properties to the new location.
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See also

Synchronize Organizer with the model (page 60)

Categories in Organizer (page 35)

Delete a category in Organizer
You can delete categories in Organizer. Note that there must be at least one
location category, one property category and one custom category in the
Organizer category tree. You cannot delete the last categories.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Select a category. 

You can select more than one category.

3. Right-click and select Delete. 

If you have used the selected category in the property rules of other
categories, Organizer shows a dialog box where these categories are
listed.

4. Click Yes to delete. 

NOTE To permanently delete a subcategory from a category created with the Create
automated subcategories command, you must remove the subcategory
objects from the main category. If you do not remove the objects from the
main category, the subcategory will be created again based on the main
category rules when you synchronize Organizer.

See also

Categories in Organizer (page 35)

Customized default setup for Organizer
You can customize Organizer by creating a setup that opens the same
templates and categories in all new models. A customized setup is useful if
you have templates and categories you want to use in all models. Then you do
not need to create or import the templates and categories for each model
separately. The customized setup is used when you open Organizer in a
model for the first time.

You can also exclude some object types (page 59) from Organizer using the
ExcludedTypesFromOrganizer.xaml file. Excluded object types are not
displayed in Object Browser and they are not included in categories.

To make the customized property templates and categories available in all
models, store the templates in the \ProjectOrganizerData
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\PropertyTemplates folder and the categories in the
\ProjectOrganizerData\DefaultCategoryTrees folder. The templates
and categories are stored as in the xml format. Property template files have
the .propertytemplate file extension and categories have the .category
file extension.

NOTE The defined location categories are automatically imported but they behave
like manually created categories. Automatic categories need to be defined in
each model separately.

You can have the folders under any or all of the following folders:

• Current model folder

• Project folder, defined in the XS_PROJECT advanced option

• Firm folder, defined in the XS_FIRM advanced option

• Folders defined in the XS_SYSTEM advanced option

Example of folders:

All templates and categories in these folders are loaded to Organizer when
you open it for the first time in a model. If there are many files with the same
file name in several different folders, the first file found is loaded and the
other files with the same file name are ignored. The search order is always:
model, project, firm, system. The roles.ini does not affect this order.

For example, if you have rebar.category, category.category and
material.category in a system folder \ProjectOrganizerData
\DefaultCategoryTrees folder, these files will all be loaded automatically to
the categories. If you also have a rebar.category file in the \PROJECT
\ProjectOrganizerData\DefaultCategoryTrees folder and in the
\model\ProjectOrganizerData\DefaultCategoryTrees folder, only the
first rebar.category file found is used. In this case, the file under the model
folder would be the first one found.

NOTE You can use the roles.ini files to control multiple setups. For example,
create a \Concrete\ProjectOrganizerData folder and a \Steel
\ProjectOrganizerData folder under the firm folder. Then define in the
roles.ini file which of these folders is read and/or in which order the
folders are read. This way you can read only the \Concrete folder files, or
read the \Concrete folder first. In this case, the files with the same name in
the steel folder are ignored.

The loaded templates and categories are saved in the ProjOrg.db in the
\ProjectOrganizer folder under the model folder. When you open
Organizer for the first time, the ProjOrg.db is created and the files are read
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in from the model, project, firm and system folders. The ProjOrg.db
database stores all template and category information used in the model.
When you make changes to the templates and categories in the folders, they
are not automatically updated in ProjOrg.db. The database will not read in
the template and category xml files again, so updates to the files will not be
automatically applied.

If you want to apply the changed templates and categories to the ProjOrg
database, you have two options:

• Delete the old templates and categories in Organizer and import the
changed templates and categories. We recommend that you use this
option.

• Export from Organizer all the templates and categories that you want to
keep and close the model. Delete the ProjOrg.db database from the
\ProjectOrganizer folder under the model folder, and re-open the
model. Import the exported templates and categories back to Organizer.

NOTE The second option will reset Organizer completely. All data will be
lost if not exported.

See also

Categories in Organizer (page 35)

Import a category to Organizer (page 66)

Import a property template to Organizer (page 33)

Export a category from Organizer (page 64)

Export a property template from Organizer (page 34)

Excluding object types from Organizer
Some object types can be excluded from Organizer. These object types are
listed in the ExcludedTypesFromOrganizer.xaml file that is by default
located in the \system\ProjectOrganizerData folder in the Common
environment. The location may vary depending on your environment.
Excluded object types are not displayed in Object Browser and they are not
included in categories, even if you select in the category rules to include a
model and all its objects to a category. For example, loads, cuts and fittings are
listed in the ExcludedTypesFromOrganizer.xaml file and excluded from
Organizer.

You can modify the ExcludedTypesFromOrganizer.xaml file to either
include or exclude the object types. Before you modify the file, we recommend
that you copy it to the \ProjectOrganizerData folder that is under the
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model folder. You may need to create the \ProjectOrganizerData folder as
it does not by default exist in the model folder.

For example, to exclude fittings, change the value as follows:

<Fitting>true</Fitting> to <Fitting>false</Fitting>
To include fittings again, change the value false back to true.

To apply the changes, click  in Categories to fully synchronize Organizer
with the model.

NOTE Do not add or remove any lines from the
ExcludedTypesFromOrganizer.xaml file, otherwise Organizer will not be
able to use the file.

You can also customize Organizer by creating a setup (page 57) that opens the
same templates and categories in all new models. A customized setup is useful
if you have templates and categories you want to use in all models.

1.7 Synchronize Organizer with the model
You can synchronize Organizer with the model to ensure that the categories
are up to date and that Object Browser shows the latest object property
values from the model. You can also synchronize individual categories or
reload the Object Browser view.

Synchronization adds location information (page 63) to model object
properties. You can use the location information when creating reports and
inquiries.

Synchronize Organizer

Synchronizing Organizer  updates all properties of the changed objects in
the Organizer database. You do not need to reload Object Browser if you
change the selection in the model, or select another category or property
template. When you have synchronized Organizer, the object properties are
up to date until you make changes in the model.

Organizer is synchronized:

• When you click  Synchronize with the model..

• When you open Organizer and select to synchronize it.

To make synchronization faster, set the XS_COLLECT_MODEL_HISTORY
advanced option to TRUE. If XS_COLLECT_MODEL_HISTORY is set to FALSE, at
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synchronization all objects are loaded to check what has been deleted in the
model.

When you synchronize Organizer, the Tekla Structures action history that is
used in undoing the last action is deleted. This means that you cannot use the

Undo (Ctrl + Z)  command immediately after you have synchronized.
Otherwise, Undo works normally.

Note that the Undo history list  is cleared when you synchronize
Organizer. The Undo history list shows all the commands that you have run
and the modifications that you have made in the model. Saving the model also
clears the list.

You can define in Organizer Settings  that Organizer is always
synchronized when you open it. Go to the Synchronization tab and select the
Always synchronize Organizer with the model when opening check box.

When you open Organizer and select the Do not show this dialog again.
check box in the Synchronize dialog box, Organizer does not show the
Synchronize dialog box anymore in any model where you use Organizer. To
get the Synchronize dialog box back, browse to the \users\<user>
\AppData\Local\Trimble folder and delete all the files starting with
ObjectBrowser. Note that deleting these files deletes the default Organizer
unit settings. Check the unit settings in Organizer Settings.

Update the whole Organizer database
You can update the whole Organizer database so that the properties you have
viewed in Object Browser, or that are used in categories, are updated to all
model objects in the Organizer database.

The Organizer database is updated:

• When you press Ctrl +  Synchronize with the model.

• When you open a model that was saved with an older Tekla Structures

version and click Synchronize with the model.

• When you select or clear the Pour units enabled setting on the
Synchronization tab in Organizer Settings, and then close the Settings
dialog box. The Pour units enabled setting controls whether Organizer
uses pour units or cast-in-place cast units as the highest cast-in-place
hierarchy in the categories.

• When you change any model-specific advanced option and the next time

click Synchronize with the model.

• When you save the model with Save as and the next time click 
Synchronize with the model.
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• When you change the material catalog and the next time click 
Synchronize with the model.

Reload Object Browser

Click the  reload button in Object Browser when you want to view the
latest property values from the model. Once you have viewed a property of
any object in Organizer, the property will be updated in the Organizer
database at synchronization.

If you make changes in the model while viewing the objects, reload Object
Browser.

NOTE When you select objects in the model or in the categories, Object Browser
shows the properties that are already in the Organizer database, and loads
the new values from the model to the properties that are not yet in the
Organizer database.

You have to Reload the view  in Object Browser to update the view with
the new values.

Synchronize a category
Organizer is partially synchronized:

• When you select a category, right-click and select Synchronize category.

To view the synchronization date and time, right-click the category again.

• When you synchronize categories at export.

Partial synchronization:

• Synchronizes the whole project when you synchronize any location
category, such as a Floor.

• Synchronizes the categories that are used in the category rules of other
categories when you synchronize these other categories.

• Synchronizes the whole category tree created by automated subcategory
rules when you synchronize one subcategory in the tree.

• Synchronizes the whole category tree when you synchronize a manually
created subcategory in a property category tree.

NOTE Partial synchronization does not update the properties shown in Object

Browser. You need to reload  Object Browser to show the updated
category content.

Exclude a category from synchronization
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1. Select a category, right-click and select Properties.

2. Clear the Update category at synchronization check box.

The objects that are deleted from the model are removed from the category
even if the Update category at synchronization option is not selected.

1.8 Report Organizer location categories
You can use location category properties in reports. If you have more than one
project in a model, you need to select which project, including the
subcategories in the project, is used in reporting. You can use only one project
at a time. You can write the report properties to the model.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Select a Project.

3. Right-click and select Use for reporting. 

The icon in front of the Project that is selected for reporting is shown as

black .

4. Right-click the Project again and select Write to the model for
reporting. 

The report properties are updated to the model.

The location properties of the assembly level objects in the model are:

• LBS_PROJECT
• LBS_BUILDING
• LBS_SECTION
• LBS_SITE
• LBS_FLOOR
• LBS_FLOOR_ELEVATION
• LBS_HIERARCHY_LEVEL_NUMBER
• LBS_HIERARCHY

5. To change the project used for reporting, select another Project, right-
click and select Use for reporting.

6. Right-click the Project again, and select Write to the model for
reporting. 

The report properties are updated to the model.

The report properties are also written to the model when you synchronize

 Organizer with the model.
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NOTE When using location properties in a report template, you need to add 
LOCATION_BREAKDOWN_STRUCTURE to the property name, for example, 
LOCATION_BREAKDOWN_STRUCTURE.LBS_FLOOR.

See also

Categories in Organizer (page 35)

Synchronize Organizer with the model (page 60)

1.9 Export a category from Organizer
You can export categories from Organizer to an xml format file and use the
exported categories in other models. You can export the selected categories,
or all location categories, custom categories, and property categories at a time.
Organizer creates only one .category export file even if you export more
than one category at a time. By exporting categories you can ensure that you
have back-up copies of the categories you have created.

For information on how to use the firm, project and system folders with
Organizer, see Customized default setup for Organizer (page 57).

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Select one or more categories.

3. Click  and select Export Organizer categories.

4. Define the export settings.

a. Select All categories or Selected categories with their
subcategories. 

• Exporting location categories: The whole project is exported even
if you only select a subcategory in the project, for example, a floor.

• Exporting categories that have been created using rules: The
whole category tree is exported. If you select a subcategory, the
main category and the other subcategories in the category tree
are also exported.

• Exporting property categories: The whole category tree is
exported. If you select a subcategory, the main category and the
other subcategories in the category tree are also exported.

• Exporting categories that have been created manually: Only the
selected category is exported.

b. Select the Include the properties of the categories check box to
include category properties in the export. 
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• If the rules in category properties include a filter, and you plan to
use the category in another model, the filter must be available in
that model. Otherwise, the category will not have the correct
content.

• If you do not select Include the properties of the categories,
only the category name is exported. The property template is set
to the default template in the export.

c. Select the Include the objects check box to include the object GUIDs
in the export. 

If the exported category is used in other models, the categories will
be empty.

d. Select the Synchronize the categories before export check box if
you want to ensure that the latest model changes are included in the
export.

5. Click Browse to select the destination folder. 

By default, the category is exported to the \ProjectOrganizer folder in
the current model folder.

6. Click Export. 

If the category you are exporting includes other categories in the category
property rules, and you have not selected these other categories to the
export, the Export category structure references dialog box is
displayed.

a. Export the valid references exports categories including the rules
defined in the category. 

This option is dimmed when you have not selected the categories
defined in the rules for export. Click Cancel and select the category to
export and the categories used in the rules. When you do this, the
Export category structure references dialog box is not shown at all.
In import, all exported categories will now be imported.

b. Export without references exports the object GUIDs in the
categories if you have selected the Include the objects check box in
the Export category structure dialog box. 

If you have not selected to include the objects, only the category
name is exported. In import, Organizer treats this category as a
manually created category.

7. Click OK.

See also

Import a category to Organizer (page 66)

Categories in Organizer (page 35)
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1.10 Import a category to Organizer
You can import categories that have been exported from Organizer in the
current model or in other Tekla Structures models. The category import files
are in the xml format, and have the .category file extension. You can import
one .category file at a time. The file can contain many categories.

For information on how to use the firm, project and system folders with
Organizer, see Customized default setup for Organizer (page 57).

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Click  and select Import Organizer categories.

3. Click Browse.

4. Select the .category file you want to import.

5. Click Open.

6. Click Import. 

If the category you are importing has the same name as an existing
category, you have the following options:

• You can import the category and replace the existing category.

• You can select not to import the category.

• You can import the category but keep the existing category. If you
import a category that has the same name as an existing category,
Organizer adds a running number to the category name.

Location categories are added at the end of the location categories, property
categories at the end of property categories, and custom categories at the end
of the custom categories.

NOTE If the imported category does not contain any objects, check if the
rules in the category properties have a filter that does not exist in the
model. When you add the filter to the model, the category content is
updated. Another reason could be that there are no objects in the
model that match the rules.

The category may also be empty if it has only manually added content
and the objects were not included in the export. If you have imported
the category from another model, the manually added content is not
imported.

See also

Categories created in earlier Tekla Structures versions (page 67)

Export a category from Organizer (page 64)

Categories in Organizer (page 35)
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Categories created in earlier Tekla Structures versions
If you have used the Model Organizer tool in the same model in an earlier
Tekla Structures version, the categories created in Model Organizer are
automatically transferred to Organizer. Model Organizer categories are
shown in the custom categories in Organizer.

When you are using Organizer in a model created in an earlier Tekla
Structures version:

• If you have never opened Model Organizer in the earlier Tekla Structures
version model, no categories are imported.

• If you have opened and closed Model Organizer in the earlier Tekla
Structures version model, the project and site logical area categories are
imported to Organizer.

• If you have added at least one object to the Model Organizer logical area
categories, the logical area categories are imported to Organizer.

• If you have added at least one object to the Model Organizer object type
categories, all the categories are imported to Organizer.

Model Organizer property sets are imported to Organizer, converted to
property templates, and named after the categories. If several categories have
the same name, a running number is added to the property template name.

See also

Import a category to Organizer (page 66)

Categories in Organizer (page 35)

1.11 Import IFC categories to Organizer
You can import the location breakdown structure of an IFC model as IFC
categories to the location categories in Organizer.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Select a Project, right-click and select New IFC project.

3. Select the IFC model.

4. Click Import. 

The IFC categories are imported at the bottom of location categories. The
objects of the imported IFC model are automatically included in the IFC
categories.

5. If the IFC model is changed, you can update the latest version of the
model to the categories. Select the highest IFC category level in the
category tree, right-click and select Update.
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TIP If you import IFC categories that have the same name as existing IFC categories,
Organizer adds a running number to the category name. You can rename the
categories.

See also

Categories in Organizer (page 35)

1.12 Organizer in the multi-user mode
When using Organizer in the multi-user mode, only one user at a time can
save changes. The first user who opens Organizer becomes the main user and
is the only user who can save changes. When the main user closes Organizer
and saves the model, another user who wants to save changes must first close
Organizer and open it again to be able to save changes.

If there already is a main user in Organizer when another user opens
Organizer, the other user will get a message that the database is locked and
that changes cannot be saved permanently. Note that even though only one
user at a time can save changes, other users can still select, create and modify
categories and property templates. Other users can export the categories and
property templates they have changed, and import them back to Organizer
for saving.

NOTE Organizer data is not shared in Tekla Model Sharing.

See also

Organizer (page 7)

1.13 Example: Organize the model into location and
custom categories, and view quantities
This example will go through the basic workflow of setting up Organizer, and
creating concrete and reinforcing bar take-offs.

You will use Organizer to organize your model into buildings, sections and
floors based on the locations in the model. You will create a category tree
structure and custom categories. When you have created the locations and
custom categories, it is fast and easy to view and report quantities in Object
Browser.

In the example, the set-up is done using the Cast in Place Sample model
that is available in the Default environment as a model template. You can
delete the existing set-up or just create a new project and start setting that up.

Organizer 68 Organizer in the multi-user mode



Example: Organize the model to buildings, sections and
floors
You will now organize your model to location categories (page 37).

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Select the Building category under Project, right-click and select Define
boundary boxes for locations.

3. Adjust the boundary box for the building by selecting or entering
coordinates. 
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4. Go to the Sections tab and add two sections to your building using the
values shown in the image below. 
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You can click the blue box in front of the section name to visualize the
section in the model. The image below shows the Frame section.

5. Go to the Floors tab and create a floor system for the Frame section
based on the grid lines. 
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6. Click Modify and Close. 

You have now organized the model to sections and floors based on
locations.

7. There are three ramp objects that are located in the Basement of the
Frame section. You have to move these manually to the Ramp section:

a. Select the Basement category, right-click and select Select in the
model to view the objects in the model. 

b. Select the three ramp objects in the model.

c. Right-click the Ramp category and select Move the selected objects.
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Example: Create a custom category with automated
subcategories based on object names in Organizer
You will now create a custom category (page 47) for assemblies, and divide the
category to subcategories based on the assembly name.

1. Click  to create a new custom category.

2. Right-click the Custom Category and select Properties. Rename the
category as Object.

3. Under Automated object content, add the material filters Material -
Concrete and Material - Steel to the rules. You can also select the
Tekla Structures model to include the Tekla Structures objects in the
category content. 

4. Click Modify to add the objects to the category.

5. Next, group the objects in Object Browser. Click  and select Group to
create a grouping based on the Name column. The grouping you see in
Object Browser is a preview of the automated subcategories. 
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6. Now create automated subcategories for the category based on object
names. Right-click the new category, select Properties and under
Automated subcategories, click Grouping in Object Browser. This adds
the object properties that are used in the grouping to the category
properties.

7. Select the Include the highest assembly level in the model check box. 

Selecting Include the highest assembly level in the model ensures that
only assemblies and cast units are included in the category. Otherwise,
the category will include both parts and assemblies. Using assemblies in
categories is important because later you will select and view multiple
different categories, and this will require using hierarchical dependencies
for objects. Also, Organizer is built to work with assemblies.

8. Select the Default property template for Object Browser.

9. Click Modify.

The subcategories are created under the Object category. If you now make
changes to the model, the category and the subcategories will be updated. For
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example, new subcategories are created and old ones deleted based on the
names found in the model.

Next, you will create a custom category for reinforcing bars.

Example: Create a custom category for reinforcing bars in
Organizer
You will now create a custom category (page 47) for reinforcing bars.

1. Create a new category and name it Reinforcement. Select to use the 
Object type - Reinforcement filter in the category property rules. 
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If you do not have a filter for reinforcement, click Object group and create
a filter as shown in the image below.

2. Select a property template for Object Browser. In this example, you
select the Rebar template. For this category, do not select the Include the
highest assembly level in the model check box. If you select to include
only assemblies, you will get all assemblies that contain reinforcing bars.
The highest assembly level for reinforcing bars is cast unit. Create
subcategories based on the nominal diameter.

3. Click Modify to create the category.

You have now created the categories you need and you can start creating
reports.

Next, you will create a concrete quantity take-off and a reinforcing bar quantity
take-off for specific objects in a specific location.

NOTE You can customize Categories to open with a set of default categories
to avoid creating frequently used categories for each project. Export
the desired categories (page 64) in the xml format as a .category
file. Save the file to your firm folder under \ProjectOrganizerData.

Example: Create a concrete quantity take-off using
Organizer
You will now get the quantities (page 8) and formwork areas for the columns
on the first floor. You need accurate quantities to order materials (formwork
plywood and concrete), or just to plan your work.

1. Select the Floor 1 and Column categories in the category tree.

2. Select a property template for quantity take-offs. Object Browser now
shows the quantities of the columns on the first floor. 

Organizer 76 Example: Organize the model into location and
custom categories, and view quantities



In this example, you have 19 columns with a total volume of 8.7 m3. You
can now create a report by exporting, or you can just check the objects
individually. Or, you can just use the total volume and call the concrete
supplier to order the needed concrete to the site.

3. Select a property template for formwork. Using a different property
template allows you to get different information on your selection. 
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You now get the total formwork area for columns. The formwork area is
calculated using a formula (page 30). You can also see the individual
formwork area of each column.

4. To check for discrepancies, you can select columns and locate them in the
model for visual checking:

a. Select the columns in Objects Browser.

b. Right-click on the selected rows and select Select in the model.

c. Press Ctrl+5 to show only the selected columns. Other objects are
almost completely transparent.

d. Press Ctrl+4 to show the object surfaces again.
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Next, you will create a quantity take-off for the reinforcing bars in the first floor
columns.

Example: Create a reinforcing bar quantity take-off using
Organizer
You will now get the quantities (page 8) of the reinforcing bars of the columns
on the first floor.

1. Select the Floor 1 and Reinforcement categories, and the Column
subcategory.

2. Click  to view the categories as unions and intersections in the
selection pane, as shown in the image below. In this example, you need
the intersections of the categories. 
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Object Browser shows the reinforcing bars that belong to the columns on
Floor 1 using a combination of the property templates of all the selected
categories. You can select a different property template to view other
properties, and change the grouping and sorting of the properties.

You can change your category selection for different union and
intersection combinations. For example, you can add more than one floor
category to get a union of the categories.
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3. Click Export  to create an Excel file (page 64) of your selection.

If you need the same report often, you can save your selection as a new
category and set the desired template as the default property template. You
can use categories in the rules to define the content of the new category. This
is useful especially when you are building your model, and want to
automatically include model changes in the category.

1.14 Example: Track modeling and planning issues using
Organizer
You can use Organizer to highlight objects with certain properties. This
functionality is useful for detailers and contractors, or anyone who wants to
check abnormalities during modeling or planning.

Example: Track reinforcing bar length using Organizer
In this example, the maximum reinforcing bar length in your stock is 12
meters. All the reinforcing bars in your model should therefore be under 12
meters. You can use Organizer to track reinforcing bars that are longer than
12 meters.

1. Create a new category and name it Rebar length over 12 m in Category
Properties. Click Object group to create a filter for the category and set it
up as shown in the image below. The value is shown in millimeters. 
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2. Save the filter with a unique name using Save as.

3. In Category Properties, add the filter you created to the rule box, and an
Object Browser property template if needed. Note that if you select the
Include the highest assembly level in the model check box, you will get
the assemblies and cast units that contain reinforcing bars longer than 12
meters.

4. Click Modify. The reinforcing bars that are longer than 12 meters are now
included in the category. In this example, there are 208 reinforcing bars
longer than 12 meters.

5. Select the category and view the content in Object Browser. You can
group the reinforcing bars in the category based on their length or
location, for example. You can also select them in the model through
category, or select them in the Object Browser listing and right-click to
select them in the model.
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6. Before your floor will go to fabrication, you may want to do a final check.
You can select the Floor 2 and Rebar length over 12 m categories to
check if there are any reinforcing bars that are too long on the floor. In
this example, there are 9 such bars. 
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Other possible use cases

You can also check reference models that contain reinforcing bars. In this
example, the IFC model has been created with Tekla Structures.

1. First, create a filter as shown in the image below. Click  to set the filter
type to Organizer.

2. Then, create a new category using this filter.

3. Ensure that your reference model is subdivided to be able to include
reference objects to categories.
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TIP If you have a reference model that has been created with some other software,
an easy way to find out the string for the filter is to use the Inquire command.
Select an object and right-click. Find the desired value string from the Inquire
dialog box, and copy and paste the value as a property to the filter dialog box,
and add EXTERNAL. in front of the property name.

Example: Track too heavy precast elements from a
reference model using Organizer
You can track precast element weights in Organizer by creating selection
filters.

1. Create a new category.

2. Create filters to track precast element weights.

a. Create a filter to track a weight over 10 tonnes. 

b. Create a filter to track a weight under 1 tonne. 

c. Create a filter to track a weight within a certain limit. 
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3. When you have created the category and the filters, add a suitable filter to
the category property rules and save the category.

NOTE You can also use this similar process with Tekla Structures objects, for
example, to track both steel assembly and cast unit weights with one filter.
Here is an example of such a filter:

This filter selects all steel assemblies and concrete cast units that are under 13
tonnes. The hierarchy level attribute is needed to get the main assembly
weight.

Example: Create weight group categories to track different
weights using Organizer
You can create selection filters to track different weights in Organizer.

1. Create a suitable filter to create categories for weights, for example,

Weight 5 - 10t as shown in the image below. Click  to set the filter
type to Organizer. 

Organizer 86 Example: Track modeling and planning issues
using Organizer



2. You can now create categories for the weight intervals and track locations.
You can use the categories like other categories, for example, you could
track first floor weights. You can also use the same logic with other
properties, such as volume, length, and area. Adjust the filter rules
depending on what you want to track. 

Example: Track large concrete volumes using Organizer
It may sometimes happen that the volumes in the model accidentally exceed
certain limits. Such limits could be the daily pour rate and delivery rate. You
can use Organizer to track the limits.

1. Create a new category and name the category as Pour volume over
140m3.

2. In Category Properties, click Object group to create a filter for selecting
volumes larger than the daily delivery maximum and set it up as shown in
the image below. In this example, the daily delivery limit is 140 m3. The
unit is mm3. 
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3. Add the filter you created in the category rules and select the Include the
highest assembly level in the model check box. Save the category
properties. 

Note that if you are doing this with pour objects as shown in the image
below, use a pour object filter and do not select the Include the highest
assembly level in the model check box.

You can now start planning based on the result. For example, you may need a
bigger crane, or maybe the elements should be smaller. Perhaps the four
pours you have should be divided into smaller pours, or maybe you need
more concrete delivered to the site.
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1.15 Example: Report areas based on object groups in
Organizer
In this example, you will use property categories to create a report on different
area calculations for the selected object groups.

First you will create property categories to define the group of objects that
need different area calculations. Then you will create formulas for the area
calculations, and finally you will add the formulas to the corresponding
categories to write the formula results to the model objects. As a result, the
objects in the different categories will have different area values in the report.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Create a property category (page 43). 

Add all model objects to the property category, and create subcategories

for the different area calculations you need. You can use object  or

assembly  type of categories according to your needs. To use
assemblies, select the Include the highest assembly level in the model
option in the category properties.
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3. Create a property (page 28) to report the calculated areas. 

Open the Settings dialog box in Organizer,

and create the property using the following settings:

• Name: Area_calculated
• Property: Area_calculated
• Unit type: Area

• Data type: Number with decimals

• Property type: UDA
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4. Add the property to the property template you are using to show it as a
column in Object Browser, and click Modify. 

5. Create separate formulas (page 30) for the categories. 
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6. Add the property and the formulas you created to the Area definition
categories to write the UDA values to the model objects.

a. Add the Area_calculated property in the category properties of the
root-level Area definition category. 
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Search for the property in Object properties, select it, and click
Modify.

b. Add a value to the property in the category properties of each lowest-
level subcategory. 
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• Type: Formula

• Value: Select a formula you previously created.
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7. Synchronize Organizer to calculate the new UDA values and write them to
the model objects. 

8. View the report in Object Browser. 
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The Area_calculated column in Object Browser shows the areas of the
objects according to the categories they belong to.

1.16 Example: Calculate and report areas based on object
type and project status in Organizer
In this example, you will create property categories based on the project
status. During the project you will move the objects between the categories to
reflect the current status of the objects. You will also create property
categories to report the area calculations for the selected object groups.

You will combine the properties that the project status and area calculation
property categories add to the objects. The report will not show any values for
the areas of the objects that are early in the delivery chain, but it shows object
type-specific areas for the rest of the objects that are in the later phases in the
delivery chain.

To report area values, you will set up two conditions for special area reporting:
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• Do not show the area of the objects if the project status is Approved for
production, but show the area if the project status is something else.

• Calculate the area based on a predefined categorization of the objects.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Set up the rules for project status. 

First create property categories to define the project statuses of the
objects. Then create a property that you will add to these categories to
define whether certain report fields get values.

a. Create a property category (page 43) for the project statuses. 
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Add all model objects, or a smaller set of objects, to the root-level
category, and then create subcategories according to the project
statuses.

You can use object  or assembly  type of categories according
to your needs. To use assemblies, select the Include the highest
assembly level in the model option in the category properties.

b. Create a property (page 28) for the calculations. 

Open the Settings dialog box in Organizer,

and create the property using the following settings:

• Name: Quantity_output
• Property: Quantity_output
• Unit type: No unit

• Data type: Number without decimals

• Property type: UDA
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c. Add the created property to the Project status categories to write
the values to the model objects. You can then use the values in
further calculations. 

• Add the Quantity_output property in the category properties of
the root-level Project status category.

Search for the property in Object properties, select it, and click
Modify.
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• Add a value of the property in the category properties of each
lowest-level subcategory.

Organizer 100 Example: Calculate and report areas based on
object type and project status in Organizer



In the Value box, add value 0 where you do not want to have any
output, and add 1 where you want to have output. You have to set
the value in each lowest-level subcategory.

3. Set up the rules for area calculation. 

First you will create property categories to define the group of objects that
need different area calculations. Then you will create formulas for the
area calculations, and finally you will add the formulas to the
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corresponding categories to write the formula results to the model
objects.

a. Create a property category for area calculations. 

Add to the category the same model objects that you have added to
the Project status category. Create subcategories according to the

area calculation types. Use the same type of category, object  or

assembly , as in the Project status category.

b. Create a property to report the calculated areas. 

Open the Settings dialog box in Organizer,

and create the property using the following settings:

• Name: Area_calculated
• Property: Area_calculated
• Unit type: Area

• Data type: Number with decimals

• Property type: UDA
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Add the property to the property template you are using to show it as
a column in Object Browser, and click Modify.

c. Create separate formulas (page 30) for all the different area
calculations. 
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If you do not need special calculations for every object type, you also
need to create a simple formula using the default area property of
the objects.
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d. Add the Area_calculated property and the formulas to the
category properties of the Area definition categories to write the
values to the model objects. 

• Add the property in the category properties of the root-level Area
definition category.

Search for the property in the Object properties, select it, and
click Modify.
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• Add a value to the property in the category properties of each
lowest-level subcategory.

• Type: Formula

• Value: Select a formula you previously created.
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4. Add the area calculations to the Project status categories. 

Create a formula that uses the Area_calculated property written to the
objects from the Area definition categories, and the Quantity_output
property written to the objects from the Project status categories.

Add the new formula to the property template you are using to show it as
a column in Object Browser, and click Modify.
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The formula calculates a property value that is shown in the
Area_for_project_status column in Object Browser. If the
Quantity_output in the formula is 1, a property value is shown in
Object Browser. If Quantity_output is 0, Organizer does not add a
value to the object property. When the Quantity_output value is 0, the
Area_for_project_status formula equals Area_calculated/0.

5. Synchronize Organizer to calculate the new UDA values and write them to
the model objects. 

Organizer 108 Example: Calculate and report areas based on
object type and project status in Organizer



You can either synchronize Organizer, or only the property category tree.

6. View the report in Object Browser. 
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In the image below, the five objects selected in Object Browser have the
area values calculated based on the definition in the Structural area
category.

In the Approved for production category, the objects have no area values
in the Area_for_project_status column, so the total sum is 0.

NOTE To show the categories as groups, select the Separate categories
option on the Object Browser menu.
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The UDAs added by Organizer are also shown in the Inquire object
dialog box.

1.17 Example: Add a classification code to objects in
Organizer and export the code to IFC
You can add a classification code to the user-defined attributes of objects
through a property category in Organizer and export the code with the
objects to an IFC file.
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1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Create the classification categories that you need as property categories
(page 43). 

Property categories have round icons in the category tree.

3. Create a custom property that you will use in the classification.

a. Click  in the upper-right corner of Organizer to open the Settings
and click Custom --> Property . 

b. Define the custom property as shown in the image below. Set the
property type to UDA.
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If you want, you can add the property to the objects.inp file to see the
property in the user-defined attributes dialog box.

4. Add the custom property to a property template. 

If you do not have a suitable property template, create a new template
(page 24).

a. Search for the custom property you created and drag it to the
selected template. 

b. Click Modify to save the template and close the settings.

5. Add the custom property to the property category you created earlier.
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a. Double-click the root property category to open the category
properties.

b. Under Object properties, select the custom property you created. 

c. Click Modify to save the changes.

Now all the subcategories under the property category have the same
custom property. The lowest subcategories will add the custom property
to the objects with the values you will define next.

6. Set the custom property value in the subcategories to add the value to the
objects. 

You can add different property values in all subcategories.

a. Double-click a lowest level subcategory to open category properties.

b. Add the custom property value that you want to write to the objects
in the selected subcategory. 
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c. Click Modify to save the changes.

7. Synchronize the property category to write the property values to the
model objects. 

Select any subcategory in the property category, right-click and select
Synchronize category.

The whole category tree is synchronized.

You can check the result in Object Browser, or by inquiring an object.

8. Add the classification code to the project properties.

a. On the File menu, click Project properties --> User-defined
attributes .

b. Add the classification code to the Classification system box. 
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Use the name that you added to the Property option when creating
the custom property.

You can add one classification code at a time this way.

9. Export the classification code to an IFC file.

a. On the File menu, click Export --> IFC . 

The classification code is exported with assemblies even if you have
added it to parts.

b. Check the result in the exported model. 
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1.18 Example: Create a custom category for structural
design status in Organizer
1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Create a new category, right-click the category and select Properties.
Enter Design Status (User Defined Attribute) as the name of the
category.

3. Set the category rules to create automated subcategories using Grouping
in Object Browser based on the design status that has been assigned for
each model part under the UDA. 
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You can now use the categories in managing the structural design status of
your project.

See also

Example: Create a custom category for architectural design status in Organizer
(page 118)

Organizer (page 7)

1.19 Example: Create a custom category for architectural
design status in Organizer
Your design team may want to communicate the design status of the parts in
their model to ensure that other project members only focus on areas where
the design has reached maturity.

1. Ensure that the architectural team places an IFC attribute to each object,
such as Architectural_Status, which can be included in the IFC file
that they share. In ArchiCAD, this can be done by simply adding an IFC
property to the objects called, for example, Status. In Revit, this can be
done by using the Revit comment attribute found on each Revit Family
Instance.

2. In Tekla Structures, use the Add model command to place the
architectural IFC model in the correct location and ensure that the model
is subdivided.

3. To open Organizer, click Manage on the ribbon and then click Organizer.
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4. Create a new category, right-click the category and select Properties.
Enter Architectural_Status as the category name.

5. Add the Object type - Reference Object filter to the rule box for
categories and filters, or a locally set filter that will find all reference
objects in the model. 

6. Create a new property to allow Tekla Structures to read comments from
the ArchiCAD / Revit IFC file. To find the name used by the IFC file, select
an IFC object, right-click and select the Inquire command. Find the
property name in the Inquire object dialog box and copy it.

7. Create a new property template. Click  in the upper-right corner of
Organizer to open the Settings and click Template. Select to create a
blank template and enter Arch_Comments_attribute as the name of the
new template. Save the template.

8. In Settings, create a new property:

a. Select Custom from the Group list.

b. Then click the Custom button and select Property. 

In this example, you will add a Revit_Comments property.

c. Enter the word EXTERNAL. in capital letters to the beginning of the
property name in the Property box, then paste or write the property
you copied in the Inquire object dialog box. 
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For example, the correct notation could be EXTERNAL.Identity
Data.Comments.

d. Click OK, add the new property to the new template, click Modify,
and close Settings.

9. Select the Architectural_Status category. Ensure that Object Browser is
showing the Arch_Comments_attribute grouping information. Right-click
the Architectural_Status category and select Create automated
subcategories to create subcategories using the property values. Create
the subcategories using Grouping in Object Browser and click Modify. 

The categories are now as follows:

You can now automatically track the status of architectural IFC objects in the
Tekla Structures model.

See also

Organizer (page 7)
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Example: Create a custom category for structural design status in Organizer
(page 117)

1.20 Example: Organizer for steel - manage bolts
You can use Organizer to quickly get the quantities of the bolts required for a
project. In addition to the raw quantities, Object Browser lets you group and
sub-total by bolt standard, diameter, and length as well as by where the bolt
will be used (shop or site).

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Click  in the upper-right corner of Organizer to open the Settings .

3. Click Template to create a new template. Enter Bolt summary as the
template name, select the Blank template option, and click Create to
create the new template.

4. Next, select BOLT from the Group list, and from the available properties
in the list drag the following properties to the Columns: 

• TYPE - The bolt standard (for example, 7990, A325, F10T).

• DIAMETER - The nominal diameter of the bolt.

• LENGTH - The nominal length of the bolt.

• SITE_WORKSHOP - Where the bolt is to be used.

• NUMBER - The number of bolts in the bolt group.

Set the In sum row show option to - for DIAMETER and LENGTH so that
the result is not shown in the sum row.

You can also add CONTENTTYPE, which shows the type of the object that is
being reported in a row. This is useful for checking the results and
identifying when something other than a bolt is being reported.

5. Click Modify to save your changes and close the Settings dialog box.

6. Select some bolts (and optionally other objects as well) in the model.

7. Click  to reload the view in Object Browser to ensure that the latest
information is shown and verify that the bolt information is correctly
reported. At this point, you could edit your Bolt summary template
further to add additional information, such as the main part phase, or
create a custom property to calculate and report the weight of the bolts,
nuts, and washers in the bolt group. 

Next, you can use Object Browser to summarize the bolt quantities in
your selection.

8. Click  in Object Browser and select Group.
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a. Drag the Type column to the grouping row. 

You now have a summary of the different types of bolts used in your
selection.

b. Drag the Diameter column and then the Length column to the right
side of Type in the grouping row. 

Object Browser now gives you a breakdown of the number of bolts
first by type, then by diameter, and then by length.

You could now also drag the SITE_WORKSHOP column at the end of the
grouping row to further break down the bolts by location, or drag the
column to the beginning of the grouping row to first break down the bolts
by location, then by type, diameter, and length. Other properties could
also be used to group and summarize the bolts.

9. Customize the template and grouping to suit your needs and click Modify
to save the template. Now you can use the grouping of your template to
categorize all the bolts in the model.

10. Next, create a new custom category, right-click the category and select
Properties. Enter Bolts as the name of the category.

11. Define the properties of the category as follows:

a. Ensure that the Include the highest assembly level in the model
check box is not selected.

b. Under Automated object content, click in the rule box for categories
and filters, and select the Object type - Bolt filter from the list of
filters. 

Note that the Object type – Bolt filter selects all bolt group
objects including the ones that create only bolt holes as well as studs.

c. Ensure that the Update category at synchronization check box is
selected.

d. Select the Bolt summary property template from the Property
template list.

e. Click Modify.

All bolt objects in the model are now added to the category. In Object
Browser, the properties of the bolts are shown using the Bolt summary
template.

You can now automatically categorize all the bolts in the model using the
same breakdown as in the bolt summary.

12. Right-click the Bolts category and select Create automated
subcategories.

13. Click Grouping in Object Browser.

14. Click Modify.
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You now have a Bolts category which is broken down into a tree based on the
grouping in your Bolt summary template. If any changes are made to the
model, you can simply synchronize this category to automatically update the
breakdown. New bolts will be found and added to the correct subcategories,
or a new subcategory will be created if necessary. For example, if a new bolt
standard or diameter is added to the model, a new subcategory for that bolt
standard or diameter will automatically be created in the tree when you
synchronize the Bolt category with the model.

You could now export the Bolt summary property template, as well as the
Bolts category for use in other projects.

See also

Example: Organizer for steel - manage assemblies (page 123)

Organizer (page 7)

1.21 Example: Organizer for steel - manage assemblies
The categories in Organizer can help manage the amount of work for a
project by breaking down the assemblies by phase and assembly type. This
can help in estimating the amount of work required to detail and/or fabricate
the project even before the model has been detailed.

This example assumes that the model has been divided into two or more
phases using Phase Manager. The model could be a design model with no
detailing, or it could be a fully detailed model.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Create a new custom category, right-click the category and select
Properties. Enter Assemblies by phase as the name of the category.

3. Define the properties of the category as follows:

a. Ensure that the Include the highest assembly level in the model
check box is selected.

b. Under Automated object content, click the Select model list and
select the Tekla Structures model to avoid getting any reference
model assemblies to the category.

c. Ensure that the Update category at synchronization check box is
selected.

d. Select the Erection property template from the Property template
list.

e. Click Modify. 

The steel assemblies in the model are now added to the category and
their erection information is shown in Object Browser.
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4. Next, click  in Object Browser and select Group:

a. Drag the Phase (or Phase Name) column to the grouping row.

b. Drag the Name column to the grouping row.

You can further group by any additional properties you would like to use
to break down the work of each phase.

5. Right-click the Assemblies by phase category and select Create
automated subcategories.

6. Click Grouping in Object Browser.

7. Click Modify. 

You now have the Assemblies by phase category broken down into
subcategories by phase, then by name.

This now gives you a breakdown of the number and kinds of assemblies in
each phase, which can be used to quickly estimate the amount of work in each
phase. As the model is detailed or changes are made to the project, you can
simply synchronize this category to automatically update the breakdown. This
could be used to track and check the workload of each phase against
production capacity or available resources as the project progresses.

Once detailing has started, the DrawingsFromModel Object Browser
property template could be used to check the availability and status of
drawings for assemblies in each phase.

See also

Example: Organizer for steel - manage bolts (page 121)

Organizer (page 7)

1.22 Example: Organizer for precast
You can use Organizer to view the properties of model objects, for example,
based on custom and standard property types.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Create delivery lot categories DeliveryLot_1…n.

3. Add sequences to the objects in cast units using Task manager or the
Sequencer tool. 

For example, if you use the Sequencer tool, enter a sequence name as
the sequence property. The sequence could be the installation sequence.
You can check that the property exists by using the Inquire object
command.

4. Click  in the upper-right corner of Organizer to open theSettings .

Organizer 124 Example: Organizer for precast



5. Create a new property template for cast units.

6. Create a custom property for the sequence property:

a. Set the Data type to Number without decimals.

b. Set the Property type to UDA.

You can use the Inquire object command to find the sequence property.
Copy the property to the Create Property dialog box in Organizer.

7. Add the custom property as a new property column to the new property
template.

8. Set the sorting of the custom property column.

9. Save the template.

10. Close the Settings.

11. Sort the cast units based on the sequence property in Object Browser.

12. Select the cast units that have the same sequence property.

13. Select Selected from the Of these rows list at the bottom in Object
Browser.

14. Select an option from the Result of list, for example, to show the total or
average weight of the selected cast units.

15. Select a delivery lot category in Categories and add the selected cast units
to the category.

16. Select the Select objects in the model option from the list at the bottom
in Categories.

17. Export the selected cast units from Settings to an Excel file.

18. You can also create property categories to quickly manage object property
data. Create a new property category and open the category properties.

19. Define the category properties:

a. Enter Fabrication Status as the category name.

b. Select the Tekla Structures model from the list of models.

c. Set the automatic object content with Organizer filters to select all
precast concrete assemblies in the delivery lot categories.

d. Select the previously created property template.

e. Under Object properties, select the UDA - FABRICATION_STATUS
property.
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20. Create automated subcategories based on UDA -
FABRICATION_STATUS. Organizer automatically creates categories based
on the properties that are now already in the user-defined attributes of
objects. 

You can also create the subcategories manually: Scheduled for
fabrication, In storage, Delivered, and On hold.

21. Now open the subcategory properties and set the type of the property to
Category name for UDA - FABRICATION_STATUS. 
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22. Now move the uncategorized delivery lot objects between the new
subcategories to easily assign statuses to the objects. Synchronize the
category with the model. 

You can also use Object Browser to conveniently overview the statuses
assigned both in the categories and in the object property dialog boxes.

See also

Organizer (page 7)

Sequencer (page 165)
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2 Building hierarchy

You can use building hierarchy to define a location breakdown structure in
your model. Building hierarchy has a default hierarchy structure, project > site
> building > level > space. You can add levels and spaces to the model by
either importing them from a reference model, or creating them directly in
your model. A level is a horizontal plane at specified elevation within a
building. Spaces are volumes that provide for certain functions within a
building.

To create a building hierarchy, set the
XS_USE_INTEGRATED_BUILDING_HIERARCHIES advanced option to TRUE. The
advanced option is by default set to FALSE.

Once you have set the advanced option to TRUE, save the model and reopen it
to apply the change. To open the Building hierarchy dialog box, go to the
Manage tab on the ribbon, and click Building hierarchy.

The defined building hierarchy and the object locations in the hierarchy are
common for all users of the model. Building hierarchy is shared when using
Tekla Model Sharing.

2.1 How to use the Building hierarchy dialog box
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 Description
1 The default hierarchy structure is project > site > building > level

> space.

You can define the name of the project in File --> Project
properties. You can modify the names and properties of sites,
buildings, levels and spaces in the table in the Building
hierarchy dialog box. When you select the project in the
hierarchy tree structure, the site is shown in the table. When you
select the site in the hierarchy tree structure, the building is
shown in the table. You can have one building in the hierarchy.

A building has one or multiple levels. When you select the
building in the hierarchy structure, the levels that are in the
selected building are shown in the table.

A level is a horizontal plane at a specified elevation. The level
elevation is in many cases defined by the architect, and it often
defines the finish floor level. Level is represented as a building
storey in IFC. When you select a level in the hierarchy tree
structure, the spaces at the selected level are shown.

Spaces are volumes that provide for certain functions, such as
rooms, within a building. A space is automatically assigned to the
closest level below it. If there are unassigned spaces in the
model, they are shown in a separate folder in the hierarchy
structure.

2 Define the level elevation.
3 Model objects are assigned to levels based on the elevation in

the model.

Use the bottom offset to define a certain distance below a level.
The objects that are within the defined distance are assigned to
the level from which the distance is defined.

By default, objects are automatically assigned to the closest level
below them.

4 Level offset defines the design level. For steel structures, this is
normally top of steel (TOS).

5 Open the Import building hierarchy dialog box to import a
building hierarchy from a reference model.

6 Click Modify to modify the objects for which you have edited the
properties in the table.

7 Delete the selected levels and spaces from the table.
8 Select which columns are shown in the table.

Your column selection is used when you open the Building
hierarchy dialog box the next time.

9 Enter additional information about the level, if needed.
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2.2 Import levels and spaces from a reference model
You can import levels and spaces from a reference model. If you already have
levels and spaces in the Building hierarchy dialog box, they will be replaced
by the levels and spaces that you import.

1. If the reference model from which you want to import the levels and
spaces is already in your model, go to step 4.

To insert a reference model to your model, click File --> Import --> Insert
reference model.

2. In the Add model dialog box, click Browse to select the reference model
from the list.

3. Click Add model.

4. On the ribbon, click Manage --> Building hierarchy to open the Building
hierarchy dialog box.

5. Click the Import button in the Building hierarchy dialog box.

6. Select the reference model from which you want to import the levels and
spaces.

You can enter characters in the Reference model name box to get a list
of the available reference models that contain the entered character.
Alternatively, you can select the model from the Reference Models side
pane, or from the model. If you select from the model, ensure that the
Select reference models selection switch is active.

The name of the reference model that you select is shown in the
Reference model name box.

7. Select the lowest level that is imported from the building hierarchy, either
level or space.

8. Click Import.

If the model already has a building hierarchy, Tekla Structures displays a
dialog box about replacing the existing hierarchy.

If you click Replace, the levels and spaces are replaced as follows:

• If you have selected Level in Lowest level to import from building
hierarchy, levels will be replaced with the imported levels.

• If you have selected Space in Lowest level to import from building
hierarchy, both levels and spaces will be replaced with the imported
levels and spaces.

The imported levels and spaces are shown in the Building hierarchy
dialog box. To have them visible in the model, ensure that you have
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selected Building hierarchy and Space in the display settings, click View
properties --> Display.

If you clear the Building hierarchy and Space check boxes in the display
settings, and click Modify, the imported levels and spaces are still shown
in the model. Use the Redraw view command to update the view.

2.3 Create levels
Levels are horizontal planes at a specified elevation within a building.

1. On the ribbon, click Manage --> Level.

Tekla Structures shows the level properties in the property pane.

2. Pick a point at the level elevation in the model, or enter the elevation in
the property pane and click the Insert level button in the property pane.

3. To create another level, pick another point. To stop creating levels, press
Esc.

2.4 Create spaces
Spaces are a volumes that provide for certain functions, such as a rooms,
within a building. A space is automatically assigned to the closest level below
it. Unassigned spaces are spaces that are not assigned to any level.

1. On the ribbon, click Manage --> Space.

Tekla Structures shows the space properties in the property pane.

2. Pick the first boundary point for the space in the model.

3. Pick the second boundary point for the space.

4. Pick the next boundary point for the space.

5. Click the middle mouse button to create the space.

The created spaces are listed in the Building hierarchy dialog box under the
levels they are assigned to.

2.5 Manage levels and spaces
You can manage levels and spaces in the Building hierarchy dialog box, or in
the property pane.

To Do this
Modify level and space properties Modify the level and space properties

in the table in the Building hierarchy
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To Do this
dialog box, or in the property pane.
The modified properties are
highlighted in yellow.

Click Modify to apply the changes in
the model.

If you change the elevation of a level
and the level has objects assigned to
it, Tekla Structures displays a dialog
box where you need to select
whether to move the level only, or the
level and the objects assigned to it.

Delete a level or a space Select a level or a space in the table in
the Building hierarchy dialog box,

and click the delete button . The
level or space is also deleted from the
model.

You can select more than one level or
space in the table to be deleted at
one go.

View to which level an assembly is
assigned to

Inquire an assembly in the model.

Show and hide levels and spaces in
the model

In View properties --> Display, check
or clear the Building hierarchy and
Space check boxes.

Filter building hierarchy objects Use the Location breakdown
structure category to filter building
hierarchy objects based on their
location.

2.6 Create views on selected levels
You can create model views of the levels that you select in the Building
hierarchy dialog box, or in the model.

1. On the View tab, click New view --> On selected levels.

2. Select levels in the Building hierarchy dialog box, or in the model.

3. In the Create views on selected levels dialog box, define the view name,
and select the view properties.

4. Select whether the view is created at the level offset.
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5. Click Create.

The created views are listed in the View list. On the ribbon, go to the View tab
and click View list.

2.7 Example: Building hierarchy in Organizer
You can use Organizer (page 7) to view the building hierarchy that you have
defined.

1. On the ribbon, click Manage --> Building hierarchy to open the Building
hierarchy dialog box.

2. On the Manage tab, click Organizer.

3. Select Synchronize in the dialog box that opens to get the building
hierarchy to Organizer.

The building hierarchy is shown at the top part of the Categories section

and it has a green icon .

When you make changes in the Building hierarchy dialog box, you need
to synchronize Organizer to get the changes to Organizer.

4. If needed, you can manually make changes in the levels, for example,
move assemblies to another level.

Select the assembly in the model, then right-click the target level in
Organizer, and click the Move the selected objects command.
Synchronize Organizer.

You can remove the changes that you have manually made. Select the

category, click  and select Manage manual changes. Select the

manually added objects marked with  or , right-click and select
Remove manual changes. Synchronize Organizer.

NOTE When you are using building hierarchy in your model, IFC export uses building
hierarchy levels when the Spatial hierarchy from Organizer setting is
selected in the IFC export dialog box. Building hierarchy spaces are not
included in the export. Note that the hierarchies created in Organizer cannot
be used at the same time.

To use the hierarchies created in Organizer in the IFC export, set 
XS_USE_INTEGRATED_BUILDING_HIERARCHIES to FALSE.
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3 Task Manager

Task manager is a tool for contractors, sub-contractors, and project
managers. Task manager allows you to incorporate time-sensitive data into
3D Tekla Structures models and to control the schedule at various stages and
levels of detail throughout the project.

With Task manager, you can create, store and manage scheduled tasks, and
link the tasks to their corresponding model objects. On the basis of the tasks,
you can create customizable model views and comprehensive 4D simulations
of the progression of the project.

You can create tasks in Task manager or import tasks from external project
management tools such as Microsoft Office Project or Primavera P6. The
import functionality allows you to preserve any schedules that you have
created outside the model environment, and thereby maintain schedule
intelligence and organization. You can supplement imported schedules with
more detail in Task manager.

The above workflow matches what can be found in a normal project delivery -
an increasing awareness of activities that support higher level project
objectives and milestones. Task manager gives you a logical storage space for
this information, and helps you extend schedule control into powerful 3D
representations.

See also

Task manager user interface (page 134)

Create a task in Task manager (page 138)

View and filter tasks in Task manager (page 150)

Import and export tasks and task types in Task manager (page 153)

Print a task schedule from Task manager (page 155)

Example: Visualize a Task manager schedule in the model (page 156)
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3.1 Task manager user interface
Task manager lists all the tasks included in the current Tekla Structures model
and shows the timescale of your project.

To open Task manager, click Manage on the ribbon and then click Tasks.

The tasks and task properties are shown as a task list in a table. Task manager
contains a set of default tasks that depend on the Tekla Structures
environment. The default tasks contain the recommended settings. You can
modify and delete the default tasks.

The Gantt chart shows the timescale of the project using the following
symbols:

Symbol Description
The task is not linked to any model object.

The task has planned start and end dates.

The task has actual start and end dates.

Shows the completeness of the task.

The task is a summary task.

Summary tasks can contain other summary
tasks as subtasks.
Shows the dependency between tasks.

Shows a milestone.

The task is locked.

The task is marked as locked  in the task list.

Modify your Task manager view
You can modify the Task manager view to show the relevant task properties
and the timescale.
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To open Task manager, click Manage on the ribbon and then click Tasks.

To Do this
Show or hide
the tasks Click  > Task List.

A check mark  in front of Task List indicates that the task
list is shown.

Show or hide
the Gantt
chart

Click  > Gantt Chart.

A check mark  in front of Gantt Chart indicates that the
Gantt chart is shown.

Show or hide a
task property
in the task list

1.
Click  > Task List Items.

2. Select a task property to show or hide it.

A check mark  in front of the property indicates that the
property is shown.

When you open Task manager the next time, the selections
you made in the previous Task manager session are in use.

Show or hide a
task property
in the Gantt
Chart

1.
Click  > Gantt Chart Settings.

2. Select a task property to show or hide it.

Note that you must have the actual start and end dates
defined for a task to show them in the Gantt chart.

A check mark  in front of the property indicates that the
property is shown in the Gantt chart.

Change how
dates and time
are shown in
Task manager

1.
Click  > Date and time format.

2. Select the format that you want to use.

The default format in Task manager shows the dates and
time as set in the Windows regional and language settings.

Change the
Gantt chart
timescale

1.
Click .

2. Select a timescale option.

Fit to the project automatically selects the appropriate
timescale option to show the whole project schedule in the
Gantt chart.

You can also change the timescale by dragging the mouse on
the Gantt chart. Hold down the right mouse button and drag
the mouse to the left to make the timescale narrower, and to
the right to make the timescale wider.
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To Do this
Zoom in the
Gantt chart

• To zoom to a task in the Gantt chart, select a task in the
task list and press Ctrl + 1.

• To zoom to the whole scenario, press Ctrl + 2.

• To place the Gantt chart symbol of the selected task in the
middle of the chart, press Ctrl + 3.

Change the
size of the
buttons in
Task manager

Click  > Large icons.

Change the
colors of Gantt
chart symbols

1.
Click  > Set Colors.

2. Click the color you want to change.

3. Select a color.

4. Click OK.
Keep the Task
manager
dialog box on
top of other
windows on
your screen

Click  > Stay on top.

Modify the calendar in Task manager
Task manager has a calendar that is used when calculating the task length.
You can modify the calendar by adding, modifying and removing holidays and
other non-working periods.

Non-working periods change the task duration automatically but they do not
change the planned or actual end dates of a task. This means that the
workload of the task may change. For example, adding an extra non-working
day for a one-week task changes the duration from 5 to 4 days increasing the
workload of one day. Weekends are by default non-working periods.

To open Task manager, click Manage on the ribbon and then click Tasks.

To Do this
Set the length of
the working day

1.
Click  > Non-working Periods....

2. Type the working hours in the From and To boxes.

3. Click Set working day.

4. Click OK.
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To Do this
Add non-working
periods to the
calendar

1.
Click  > Non-working Periods....

2. Click Add.

3. Type a descriptive name in the Name box.

4. Select the Start date and the End date.

5. Set the Recurrence frequency to non-recurring,
weekly or yearly.

6. Set the Range of recurrence for recurrent non-
working periods.

7. Click OK.

To modify a non-working period, select a period in the
Non-working Periods dialog box and click Modify.

To delete a non-working period, select a period in the
Non-working Periods dialog box and click Remove.

Import a holiday
file from Microsoft
Outlook

1.
Click  > Non-working Periods....

2. Click Import Holidays....

3. Browse for the holiday file.

4. Select the country from the list.

5. Click OK.
Import a calendar You can import a calendar from Microsoft Project, for

example.

NOTE The imported calendar overrides the existing
calendar in Task manager.

1.
Click  > Import....

2. Browse for the file to import.

3. Select the Import calendar option.

4. Click OK.

3.2 Create a task in Task manager
You can create scheduled tasks in Task manager and link the tasks to the
relevant model objects. Each task must have at least a name, and a planned
start date and end date. The tasks in Task manager are saved when you save
the Tekla Structures model.
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You can create a task both in the model and in Task manager. To open Task
manager, click Manage on the ribbon and then click Tasks.

• In the model, select one or more model objects, then right-click and select
Task --> Create task.

The task is automatically linked to the selected model objects.

• In Task manager, click .

If you have an existing task selected in Task manager, the properties of the
selected task are used in the new task. You can modify the properties. The
new task is not linked to any model objects yet.

You can create subtasks for a task by clicking .

If the task you created is not shown in Task manager, click anywhere on the
tasks to update the view.

When you have created a task, you can add objects to the task to link the task
to the model, and define the task properties. You can modify the task
properties either in the task list or in the Task Information dialog box. Note
that you can modify some of the properties in the Task Information dialog
box only.

TIP You can lock tasks if you want ensure that task properties are not
unintentionally changed. Select a task, right-click and select Lock task.

Locked tasks are marked with a lock  in the task list.

You can lock one or more tasks at one go. If you select several tasks, and
one or more of the tasks, but not all of them, are already locked, Task
manager shows  in front of the Lock task command.

Link a task to the model
Tasks are linked to the model through the objects that are included in the
tasks. You can add objects to a task, copy objects from one task to another,
and remove objects from a task.

To open Task manager, click Manage on the ribbon and then click Tasks.

To Do this
Add objects to
a task

1. In the model, select the objects that you want to add to
the task.

2. Do one of the following:

• Right-click and select Task --> Add to selected task.
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To Do this
• In Task manager, right-click the selected task and

click Add Selected Objects.

When you have added the objects to the task, Task manager
changes the color of the task bar to blue in the Gantt chart

and selects the Task linked to model check box  in the
task list.

Copy objects
from one task
to another

You can copy objects from one task to another in Task
manager. If you want to move all the objects of a task to
another task, you must manually remove the objects from the
original task after the copying.

1. Select the task from which you want to copy the objects.

2.
Click  to automatically select the objects in the model
to check which objects are linked to the task.

The button changes to  when it is activated.

3. Right-click the selected task and select Keep selection.

All objects linked to the task stay selected.

4. Select the task you want to copy the objects to.

5. Right-click and select Add selected objects.
Remove
objects from a
task

1. Select the task from which you want to remove the
objects.

2.
Click  to automatically select the objects in the model.

You can remove all objects from the task, or select which
objects are removed. If you do not select any objects, all
objects are removed from the task.

3. To remove all the objects from the task:

• In the model, right-click and select Task --> Remove
from selected task .

• In Task manager, right-click the selected task and
click Remove Selected Objects.

4. To remove some objects from the task:

• In Task manager, right-click the selected task and
select Task Information... --> Objects . Select the
objects you want to remove and press the Delete key.
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To Do this
• In the model, select the objects you want to remove,

right-click and select Task --> Remove from selected
task .

5. Click the view in the model, and then click the task again
in Task manager to verify that the objects were
successfully removed.

Define a task type
You can define task types for different types of tasks. In the task type, you can
define a production rate and user-defined attributes that are linked to the
objects in the task. You can define task types in advance before creating the
tasks, and then select an appropriate task type when defining the task
properties.

1. To open Task manager, click Manage on the ribbon and then click Tasks.

2. Click  > Task Types....

3. Click Add.

4. Type a name for the task type.

5. Define a production rate for the task type. 

The production rate is used when calculating task duration. Using the
production rate, you can define how many units are produced within a
certain time frame, for example, how many pieces per hour or how large
an area in an hour, 1.50 pcs/hour or 8.00 m2/hour. Task manager
automatically calculates the production rate when you define the unit,
quantity, and time.

a. Select a unit in the Unit list. 

The default unit is PIECES.

The default task type units are report properties that are listed in the
WorkTypeProperties.xml file. The file is located in the model
folder and it is created when you first open Task manager. The
report properties included in the file depend on the Tekla Structures
environment. To change a task type unit or to add new task types,
edit the WorkTypeProperties.xml file.

You can add Tekla Structures report properties, reference model
properties and calculations to the file. The display name defined in
the file is shown in the Unit column and the report property name
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value is used in Task manager. If you are adding a calculation, the
property type must be calc.

The default units of the task type units depend on the settings in File
--> Settings --> Options --> Units and decimals.

b. Type the quantity in the Quantity box.

c. Type the time in the Time box.

6. Select the planned dates user-defined attributes which are linked to the
objects in the task.

7. Click OK.

Define a contractor in Task manager
You can define contractors and assign one contractor for a task.

1. To open Task manager, click Manage on the ribbon and then click Tasks.

2. Click  > Contractors....

3. Click Add.

4. Type the contractor name.

5. Click OK.

Define general task properties
You can define general properties for a task, such as a name, task type, and
contractor.

1. To open Task manager, click Manage on the ribbon and then click Tasks.

2. Select a task in the task list.

3. Right-click and select Task Information....

4. Ensure that you are on the General tab.

5. Type the task name in the Task name box.

6. Select the Milestone check box if you want to mark the task as a
milestone. 

Task manager selects this check box automatically if you set the task
length to zero.

7. Select how the task is moved in the Gantt chart if it has a dependency with
another task: 

• Only forward moves the dependent task forward only when the
preceding task is moved forward. If the preceding task is moved
backward to an earlier date, the dependent task is not moved.

Task Manager 142 Create a task in Task manager



• Forward and backward moves the dependent task in the same
direction as the preceding task, according to the dependency type and
the possible lag time.

8. Select a task type from the Task type list. 

If you need to add a new task type, click  next to the list and click Add.
Define the task type properties and click OK.

9. Select a contractor from the Contractor list. 

If you need to add a new contractor, click  next to the list and click Add.
Type the contractor name and click OK.

10. Click OK.

TIP • You can copy property values in the task list. Right-click a property and select
Copy value. Then select another property, right-click and select Paste value.
You can paste the copied value to multiple tasks.

• You can mark several tasks as milestone tasks at one go. Select the tasks in
the task list, right-click and select Milestone task. Milestone tasks are shown

in the Gantt chart with the milestone symbol .

If you select several tasks, and one or more of the tasks, but not all of them,

are already milestone tasks, Task manager shows  in front of the
Milestone task command.

TIP You can set a default value for how dependent tasks are moved. Click  >
Task Settings... to select the value. The default value is used in all new tasks.

Define a task schedule
You can plan a schedule for a task. You can define both the start and the end
date, or enter the start date and the task length and let Task manager
calculate the end date.

1. To open Task manager, click Manage on the ribbon and then click Tasks.

2. Select a task in the task list.

3. Right-click and select Task Information....

4. Go to the Scheduling tab.

5. Select the Scheduling mode: 

• Fixed start and end

If you add objects to the task or remove objects from the task, the
production rate changes but the task length does not change.
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• Fixed start

If you add objects to the task or remove objects from the task, the task
length changes.

6. Select the Planned start date.

7. Select the Planned end date or enter the Planned length of the task. 

The planned length is shown in shifts that can be working days, for

example. Go to  > Non-working Periods... to define a working day.
When you enter the planned length, Task manager calculates the end
date for the task.

If you are using the Fixed start scheduling mode, you can enter the task
length in Planned work duration.

Task manager automatically calculates the total workload, production
rate, and work duration of the task.

8. Click OK.

TIP You can set a default value for the scheduling mode. Click  > Task
Settings... to select the value. The default value is used in all new tasks.

TIP You can also modify the length of the task in the Gantt chart. Place the mouse
pointer over the edge of the task bar in the Gantt chart. The mouse pointer
changes into a double-ended arrow. Hold down the left mouse button, and then
drag the edge to the right or to the left.

To check that the dates of subtasks are within the summary task dates, click

 > Check Dates. The conflicting dates are shown in red.

Manage the planned dates of objects in a task
You can manage the planned duration of the activities related to each object in
a task.

1. To open Task manager, click Manage on the ribbon and then click Tasks.

2. Select a task in the task list. 

Ensure that there are objects in the task and that you have defined task
types that are linked to the appropriate user-defined attributes for
planned dates.

3. Right-click and select Task Information....

4. Go to the Objects tab.
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5. Click the  function button to calculate the planned dates for the
objects in the task. 

The calculated dates are written to the corresponding user-defined
attributes in the object properties.

6. Click OK.

TIP To calculate the dates for several tasks at one go, select the tasks in the task list

and click .

Track a task schedule
You can track how a task is progressing by defining the actual schedule and
task completeness information.

1. To open Task manager, click Manage on the ribbon and then click Tasks.

2. Select a task in the task list.

3. Right-click and select Task Information....

4. Go to the Tracking tab.
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5. Select the Completeness tracking mode: 

• Automatic

If there are no objects in the task, Automatic works in the same way
as the Task level tracking mode.

If there are objects in the task, Automatic works in the same way as
the Object level tracking mode.

• Task level

Define the actual schedule and the task completeness for the task in
Task manager.

• Object level

Define the actual start and end date of individual objects in the object
properties in the model. Task manager calculates the task length and
the task completeness.

When you change the dates of an object in the model, refresh the task
in Task manager to ensure that the changed dates are shown in Task
manager.

6. Click OK.

TIP You can set a default value for the completeness tracking property. Click  >
Task Settings... to select the value. The default value is used in all new tasks.

Define the order of objects in a task
You can define and save the order in which objects are stored in a task.

1. To open Task manager, click Manage on the ribbon and then click Tasks.

2. Select a task in the task list.

3. Right-click and select Task Information....

4. Go to the Objects tab.

5. Set the sequencing order of objects:

a. Click  to select all objects in the table, or select the objects that you
want to modify.

b. Click .
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The Sequencing order column shows the order of the objects.

You can also set the sequencing order by selecting the objects in the
desired order in the model. Select objects in the table, click  and select
the objects in the model in the desired order.

6. If needed, change the order of the objects in the table: 

• Drag the object rows in the table manually to the desired order.

You can drag several object rows at a time.

• Click a table column heading to sort the objects.

Press Ctrl and select more than one column heading to sort the
objects by several columns.

7. Click OK.

TIP You can show a sequence in the model.

1. Select the objects in the table.

2. Type the speed of the object selection in seconds in the box next to the

Play  button.

For example, if you enter 2, Tekla Structures waits for 2 seconds until it
selects the next object in the sequence.

3. Click .

The objects are selected in the model in the same order as they are on the
Objects tab. The objects stay selected in the model until you click somewhere in
the model.

TIP To show the order information in the model, select one or more objects in the
table and click  or press Ctrl + D. The order information is shown on the
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selected objects in the model. For example, 2-1 means that the object belongs to
the second task in the task list and that the object is the first object in the task.

To clear the numbers from the model, right-click and select Update window.

When you define the cast-in-place work order or work groups within a task, you
can use Organizer for planning the appropriate quantities (page 68) for each
group or lot.

Define a dependency between tasks
You can define different types of dependencies between tasks in Task
manager. You can define a dependency for one task at a time.

The dependencies are represented by arrows in the Gantt chart. The arrow
points to the start or the end of the other task, depending on their
relationship. A task can also be dependent on a milestone.

A predecessor is a task that must be completed before the dependent task.
You can also define a lag between the tasks, for example, that Task1 must be
completed five days before Task2 can be started. It is not possible to create
circular dependencies in Task manager.

To define a dependency between tasks:

1. To open Task manager, click Manage on the ribbon and then click Tasks.

2. Select a task in the task list.

3. Right-click and select Task Information....

4. Go to the Dependencies tab. 

If you have more than one task selected, the Task Information... tab is
not shown.

5. Select the preceding task from the Task name list. 

You cannot select the summary task of the current task, or a task that
already has a dependency with the current task.

6. Select a dependency type from the Type list. The options are: 

• Finish-to-Start (FS): The preceding task must finish before the
dependent task can start.

You can also drag a task bar onto another task bar in the Gantt chart to
create a basic Finish-to-Start (FS) dependency with no delay days
between the tasks.

• Start-to-Start (SS): The preceding task must start before the
dependent task can start.
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• Finish-to-Finish (FF): The preceding task must finish before the
dependent task can finish.

• Start-to-Finish (SF): The preceding task must start before the
dependent task can finish.

7. If you want to add a delay between the tasks, enter a value in the Lag list. 

Define the value on a scale from 1 to 100. The time unit of the delay is
always days.

8. If needed, go to the General tab and check that the Move with
predecessor setting for how tasks are moved in the Gantt chart is
suitable.

9. Click OK.

TIP You can also modify a dependency in the Gantt chart. Right-click a dependency
arrow and do any of the following:

• Select a dependency from the list.

• Enter a new lag value and press the Enter key.

The changes are immediately visible in the Gantt chart.

Define additional information for a task
You can define additional information for a task in Task manager, such as
links to web pages, relevant documents, project schedules, and contracts.

1. To open Task manager, click Manage on the ribbon and then click Tasks.

2. Select a task in the task list.

3. Right-click and select Task Information....

4. Go to the Additional Information tab.

5. Click Add.

6. Select the file and click Open.

7. Enter additional notes in the Notes box.

8. Click OK.

Create a scenario
Tasks are included in scenarios. You can create different scenarios to define
alternative workflows, for example, for design, fabrication and erection
schedules to help you in project planning. You can also create separate weekly
scenarios for easier project follow-up.

1. To open Task manager, click Manage on the ribbon and then click Tasks.
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2. Click .

3. Click Add. 

Task manager names the new scenario as Scenario and adds a running
number to the name, for example Scenario1. You can rename the
scenario.

4. Click Open to add tasks to the new scenario.

5. Click  to create a task.

6. If needed, copy tasks from another scenario.

a. Select a scenario in the list of scenarios and click Open.

b. Select the tasks that you want to copy. 

The subtasks of the selected tasks are also copied.

c. Right-click and select Copy or Copy Without Objects.

d. Go back to the new scenario, select a location for the copied tasks in
the task list, right-click and select Paste. 

When you select a location, the copied tasks are placed on the same
level as the selected task. If you do not select any location, the copied
tasks are placed after all existing tasks.

TIP To modify the start dates of the whole scenario at one go, click  > Change
Project Start Date and select a new start date.

To delete a scenario, right-click a scenario in the list of scenarios and click
Delete.

3.3 View and filter tasks in Task manager
You can view, select, highlight and filter tasks in different ways in Task
manager.

To open Task manager, click Manage on the ribbon and then click Tasks.

Select tasks

To Do this
Select multiple
tasks

Do any of the following:

• Hold down the Ctrl key and select the tasks.

• Select the first task, hold down the Shift key and select
the last task.
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To Do this
• Select the first task and drag the mouse across the tasks

that you want to select.
Select multiple
tasks in the
Gantt chart

Do one of the following:

• Select an area in the Gantt chart.

• Drag the mouse on the header line in the Gantt chart to
select a time period.

Task manager highlights the tasks that are within the
selected area.

Show only the
selected tasks
in the task list

1. Select one or more tasks in the task list.

2.
Click .

3.
Click  to show all tasks again.

Organize tasks in the task list

To Do this
Change the
order of tasks Select a task and click  or  until the task is in the

desired location.

You can move more than one task at a time. When you move
a task, the related subtasks are also moved.

Save the order
of tasks Click  and select Save Current Order.

If you change the saved order of tasks and want Task

manager to show the saved order again, click  and
select Return to Saved Order.

Change the
hierarchy of
tasks

Select a task and do one of the following:

•
To increase the hierarchy, click .

You can change a task to a subtask.

•
To decrease the hierarchy, click .

You can change a subtask to a task.

You change the hierarchy of more than one task at a time.
Expand and
collapse task
hierarchies

Select a task and do one of the following:

• Click  to collapse the hierarchy of the selected task.
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To Do this

Click  to collapse the hierarchy of all tasks that are on
the same level as the selected task.

Press Ctrl +  to collapse the hierarchy of all tasks.

• Click  to expand the hierarchy of the selected task.

Click  to expand the hierarchy of all tasks that are on
the same level as the selected task.

Press Ctrl +  to expand the hierarchy of all tasks.
Change the
sorting
direction

Click a column heading to change the sorting direction. To
reverse the direction, click the column heading again.

View tasks in the model

To Do this
Select the
model objects
of a task in the
model

In Task manager:

1. Select a task in the task list.

2.
Click .

Highlight a task
in the model

In the model:

1.
Activate the Select tasks  selection switch.

2. Place the mouse pointer over a model object. If the
object belongs to a task, Tekla Structures highlights the
task.

The green box shows the boundaries of the task in the
model.

View the tasks
related to a
model object

In the model:

1.
Ensure that the Select tasks  selection switch is not
active.

2. Select a model object.

3. Right-click and select Task --> Show related task .

Task manager selects the related tasks in the task list. The
model objects that belong to the related tasks are
highlighted, but not selected, in the model.
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Filter tasks

To Do this
Filter tasks in
the task list

You can filter tasks by status, contractor, task type, name,
and start and end dates. You can set that the filtering shows
only those tasks that are within your selection in the model.

1.
Click .

2. Select the filters you want to use.

3. Click Filter.

4. Click Show all to show all tasks.

You can also filter tasks by entering a filter criterion in the
search box in Task manager. The search covers all the task
properties that are visible in the task list.

TIP You can create filters for tasks using the Tekla
Structures selection and view filter functionality. The
filters control which objects are shown in the model
and which objects can be selected. When you use
selection and view filters, the tasks in the current
scenario are used in the filtering.

See also

Create a task in Task manager (page 138)

Task manager user interface (page 134)

3.4 Import and export tasks and task types in Task
manager
You can import and export tasks and task type definitions as .xml files in Task
manager.

Import tasks and task types
You can import tasks and task types from external project management
software to Task manager. For example, you can import general building
schedules from Microsoft Project, and further modify them in Task manager.
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To open Task manager, click Manage on the ribbon and then click Tasks.

To Do this
Import tasks
(page 138)

You can import one task file at a time. The file can contain
more than one task.

1.
Click  > Import....

2. Browse for the file to import.

3. Select Import baseline dates to planned dates to
import the baseline dates of tasks as the planned dates.

By default, scheduled dates are imported to Task
manager as planned dates.

4. Select how the tasks are imported to Task manager:

• Append imported tasks to scenario adds the
imported tasks at the end of the task list.

• Override existing tasks replaces the existing tasks
with the imported tasks.

The links between the existing tasks and model
objects are not modified. Task dependencies are
imported.

• Override selected properties of existing tasks
imports task properties.

When you select this option, Task manager displays a
list where you can select the properties.

The links between the existing tasks and model
objects are not modified. Task dependencies are
imported.

5. Click OK.

Imported tasks are marked as imported  and locked  in
Task manager.

Import task
types
(page 138)

You can import one task type file at a time. The file can
contain more than one task type.

1.
Click  > Task Types....

2. Click Import....

3. Browse for the file to import.

4. Select how the task types are imported to Task manager:

• Override task types using the same name replaces
the existing task types that have the same task type
name as the imported task types.
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To Do this
• Append imported task types adds the imported task

types at the end of the task type list.

5. Click OK.

Export tasks and task types
You can export tasks and task types from Task manager to external project
management software.

To open Task manager, click Manage on the ribbon and then click Tasks.

To Do this
Export tasks 1.

Click  > Export....

2. Browse for the file to export.

3. Click Save.

Task dependencies are exported.

If the tasks contain only planned dates, they are exported
as scheduled dates. If the tasks contain planned dates
and actual dates, the planned dates are exported as
baseline dates and the actual dates as scheduled dates.

Export task
types

1.
Click  > Task Types....

2. Click Export....

3. Browse for the file to export.

4. Click Save.

3.5 Print a task schedule from Task manager
You can print task schedules from Task manager. By default, the schedule is
printed from the first date to the last date that is visible in the Gantt chart.

1. To open Task manager, click Manage on the ribbon and then click Tasks.

2. Click .

3. Select the suitable printing options: 

• Click Page setup... to modify the page settings.

• Select Print to the project end date to print the whole schedule even
if the end date is not visible in the Gantt chart.
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• Select Adjust to percent of normal size or Fit to pages according to
your needs.

4. If needed, click Print Preview... to view how the schedule is printed. 

You can print the schedule from the Print preview... dialog box.

5. Click Print... to print the schedule.

6. Modify the printer settings if needed.

7. Click Print.

TIP You can create reports from the task information in Task manager and list
various details about the tasks, such as the task name, task type, planned and
actual dates, and task completeness.

See also

Create a task in Task manager (page 138)

3.6 Example: Visualize a Task manager schedule in the
model
You can use the Project Status Visualization tool to review the task
schedules created in Task manager.

In this example, you will first create object groups to define which tasks are
shown in the model. The object groups are related to the current Task
manager scenario. You will then create object representation settings to
define how the tasks are shown in the model. Finally, you will review the task
schedule using the Project Status Visualization tool.

1. Create object groups for tasks:

a. In Tekla Structures, go to the View tab and click Representation.

b. Click Object group....

c. In the Object Group - Representation dialog box, create an object
group with the following settings: 

d. Enter a name for the group, for example Completed, in the box next
to the Save as button, and then click Save as.

e. Repeat steps 1c - d to create an object group called Started. Use the
following settings: 
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f. Repeat steps 1c - d to create an object group called NotStarted. Use
the following settings: 

g. Repeat steps 1c- d to create an object group called All. Use the
following settings: 

h. Click Close.

2. Create object representation settings for tasks:

a. In the Object Representation dialog box, select the object group
Completed from the list in the Object group column.

b. In the Color column, select a color for the object group, for example
blue.

c. In the Transparency column, select a transparency setting for the
object group, for example Visible.

d. Click Add row to add a new row.

e. Repeat steps 2a – d to define the color and transparency settings for
the other object groups (Started, NotStarted, and All). 

For example, you can use the following settings:

Enter a name for the object representation settings, for example
Tasks, and then click Save as.

f. Click OK.

3. Review the task schedule using Project Status Visualization:

a. In Tekla Structures, go to the Manage tab and click Project status.

b. Select Tasks from the Object representation list.
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c. Click the step buttons to change the Review date and to view the
changes in the model.

See also

Create a task in Task manager (page 138)
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4 Phase Manager

Use Phase Manager to break a model up into sections.

Phases are often used to indicate erection sequences. You can create reports
and views, hide and lock objects, and copy objects from other models,
according to their phase number.

For example, you might have a large project which several users work on
simultaneously in single-user mode. First create a basic model that includes,
for example, the columns. This is phase 1. You then copy this basic model to all
users.

Each user then works on a separate part of the building. When a part of the
model is completed, you can copy it back to the basic model as a separate
phase (phase 2, 3, etc.).

NOTE When you copy objects between models using phases, the target model must
have been created using the same or a newer version of Tekla Structures as
the source model. You cannot copy from a newer version to an older version.

4.1 Divide the model into phases
1. On the Manage tab, click Phases. 

The Phase Manager dialog box appears.

2. Click Add to create new phases.

3. Click Set current to make the selected phase the current phase. 

From now on, Tekla Structures assigns all objects you create to the current
phase. The @ character in front of the phase number indicates the current
phase.

4. Divide the model into phases.
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a. To identify the phase of an object, select an object and click Phases
by objects. 

Tekla Structures selects the phase of the object.

b. To see which objects belong to a certain phase, select a phase from
the list and then click Objects by phases. 

Tekla Structures highlights the corresponding objects in the model.

c. To change the phase of one or more objects, select the objects, select
a phase from the list, and then click Modify phase.

5. Click OK to save your changes.

4.2 Lock and unlock objects in specific phases
To protect model objects from being accidentally modified or deleted, you can
lock them. For example, you can lock parts, bolts, welds, and reference models
in a Tekla Structures model according to their phase.

When an object is locked, you cannot modify its properties or delete it. You can
only change the object’s user-defined attributes that do not affect numbering.
If you try to modify or delete a locked object, Tekla Structures displays the
following warning message:

"There are locked objects, see report. The operation could not be performed."

1. On the Manage tab, click Phases.

2. In the Phase Manager dialog box, select the phases whose objects you
want to lock or unlock.

3. Do one of the following: 

• To lock objects, click Lock objects.

Tekla Structures sets the user-defined attribute Locked to Yes for the
objects in the selected phases.

• To unlock objects, click Unlock objects.

Tekla Structures sets the user-defined attribute Locked to No for the
objects in the selected phases.

NOTE Note that assemblies, cast units, and pour units are not locked.

For information on how to protect model objects from being accidentally
modified in the multi-user mode, see Access rights in multi-user mode.
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4.3 Define custom phase properties
You can add custom phase properties, which will appear as extra columns in
the Phase Manager dialog box.

Define the names of phase properties in the objects.inp file. To use phase
properties in reports and templates, use the syntax PHASE.ATTRIBUTE_NAME
in the phase property field name.

The default objects.inp file contains a Phase attributes section with syntax
examples. For more information, see Properties of the objects.inp file and
Define and update user-defined attributes (UDAs).
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5 Lotting

With lots you can group assemblies for transporting to site. Lotting means that
you evaluate specific model parts with respect to the number of units that can
be carried by a transfer vehicle.

For example, you can calculate how many concrete truck deliveries are needed
to pour the footings or slabs for a specific portion of the model. With this
information, it is easier to determine area requirements and create an erection
schedule.

When you define lots, you must take into account the load-carrying capacity of
the vehicle, because a lot cannot exceed the maximum total load capacity. You
can calculate truck load sizes based on material weights and model quantities.
For most model parts, the weight is based on the size, length, and material of
the part.

TIP To view the properties of a part, double-click the part, or click Inquire object

 and select the part.

You can use lotting in conjunction with the Sequencer tool. For example, you
can load each part of the model onto a specific truck based on the erection
sequence of the part.

The basic lotting process is the same for steel and concrete parts. However, if
you are using cast-in-place concrete, remember that the concrete is
transported in a volumetric container (for example, in a ten-cubic-yard truck).
In that case, you must calculate the weight-carrying capacity of the concrete
vehicle before defining the number of lots.

5.1 Create a lot
Create lots to group assemblies for transporting to a site.

1. On the Manage tab, click Lotting.

2. Click Properties... to display the Lot Properties dialog box.
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3. Enter a lot number in the Number box.

4. Enter a name in the box at the bottom of the dialog box.

5. Enter the maximum weight of the lot in the Max weight box. The units
depend on the settings in File menu --> Settings --> Options --> Units
and decimals .

6. Click Add. 

Tekla Structures creates an empty lot with the defined properties.

7. Repeat the steps from 3 to 6 to add more lots.

TIP You can modify a lot name later if needed. In the Lotting dialog box, click
Properties.... Select the lot that you want to modify. Then modify the
name in the box below the list of lots, and click Modify.

5.2 Add parts to a lot
After you have created the needed lots, you must select each part of the
model and assign them to a lot until the total load weight of the lot reaches
the specified target.

1. On the Manage tab, click Lotting.

2. Select an existing lot from the list. 

Tekla Structures highlights the parts included in the lot. The total weight of
the lot and the number of assemblies it contains are displayed under
Applied values.

3. Hold down Shift and select the parts that you want to add to the lot.

4. Click Apply selected. 

The weight and the number of added parts are displayed under Current
values. Tekla Structures displays a warning message if the weight limit of
the lot is exceeded.

5. Click OK to close the dialog box. 

When you re-open the dialog box, the Applied values include the weight
and the number of parts you added.

WARNING Parts can belong only to one lot at a time. If you add parts that are
already in an another lot, the parts will be removed from that lot.

5.3 Remove parts from a lot
1. On the Manage tab, click Lotting.
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2. Select an existing lot from the list. 

Tekla Structures highlights the parts included in the lot.

3. Hold down Ctrl and select the parts that you want to remove from the lot. 

If you want to remove all the parts from the lot, click somewhere in the
model without holding down Ctrl.

Tekla Structures deselects the parts.

4. Click Apply selected.

5. Click OK to close the dialog box.

5.4 Delete a lot
1. On the Manage tab, click Lotting.

2. Click Properties....

3. Select an existing lot from the list.

4. Click Delete.
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6 Sequencer

Use the Sequencer tool to create sequences and to assign incremental
numbers to parts.

You can define several sequences for different purposes, and a part can
belong to several sequences at the same time. For example, you can create
erection sequences to define the order in which to erect parts.

Sequencer works by assigning a sequence number to a user-defined attribute
(UDA) of a part. If you want to view and modify the sequence numbers
afterwards, you must first create a new user-defined attribute to which you
assign the sequence numbers.

Limitations

Sequencer does not work for objects that are inside a reference model.

6.1 Create a sequence
1. First, create a user-defined attribute (UDA) to which you assign sequence

numbers. 

In the objects.inp file, search for the Part attributes section to add a
new user-defined attribute (UDA). The value_type must be integer,
and the field_format must be %d.

For example:

attribute("SEQUENCE_1", "Sequence 1", integer, "%d", no,
none, "0.0", "0.0")

2. In Tekla Structures, go to the Manage tab and click Sequencer. 

The Sequencer Properties dialog box opens.

3. In Sequence name, enter the name of the sequence. The sequence name
has to be exactly the same as the name of the UDA defined in the
objects.inp file. 

For example, SEQUENCE_1.
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4. Click Apply.

5. Select the parts you want to include in the sequence. 

The first part gets the sequence number 1, the second part number 2, and
so on.

The Sequencer Properties dialog box lists the sequences that you have
entered in the Sequence name box. Max number shows the highest
number that is in use in the selected sequence.

If you select a part that has already been included in the sequence, Tekla
Structures asks if you want to override the existing number. If you click
Yes, Tekla Structures gives the next available number to the part.

6. To finish adding parts to the sequence, right-click and select Interrupt or
press Esc.

6.2 Add parts to a sequence
You can add new parts at the end of an existing sequence. If you want to add
parts in the middle of the sequence, you must redefine the whole sequence.

1. On the Manage tab, click Sequencer.

2. Select a sequence name from the list.

3. Click OK or Apply.

4. Select the parts you want to add to the sequence.

5. To finish adding parts to the sequence, right-click and select Interrupt or
press Esc.

6.3 Check the sequence of a part
You can check the sequence name and number of a part by using the Inquire
object command.

1. On the ribbon, click Inquire object .

2. Select a part. 
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Tekla Structures displays the properties of the part. The sequence name
and number are displayed under More. For example:

6.4 Modify the sequence number of a part
You can modify the sequence number that has been assigned to a user-
defined attribute (UDA) of a part.

1. Double-click a part to open the part properties in the property pane.

2. Click More. 

The current sequence number is displayed next to the UDA to which you
assigned the sequence number. For example, Sequence 1.

3. Modify the sequence number.

4. Click Modify.

6.5 Delete a sequence
1. On the Manage tab, click Sequencer.

2. Select a sequence name from the list.

3. Click Delete and then click Yes.
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7 Project status visualization

Use the Project Status Visualization tool to review the status of model
objects in a specific time frame.

For example, you can use Project Status Visualization to display the erection
schedule for groups of parts using different colors, and to identify the parts
that are scheduled to be fabricated during a specific time period.

Before you can create project status visualizations, you need to define some
color and transparency settings that include object groups based on date
rules.

You can also define tasks for parts and assemblies using Task manager. The
project status visualization can then be based on tasks (page 156).

7.1 Create a visualization
Create visualization settings to view the project status of model objects in a
specific time frame.

1. On the Manage tab, click Project status to open the Project Status
Visualization dialog box.

2. Modify the visualization settings.

a. In the Object representation list, select one of the predefined object
representation settings.

b. Define a start and end date for the time scale slider.

c. Define the length of the time step.

3. Select the Refresh view automatically check box.

4. Enter a unique name in the box next to the Save as button.

5. Click Save as to save the visualization settings.

6. To view the visualization in the model, click the step buttons.
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7.2 Copy visualization settings to another model
You can copy project status visualization settings to another model. The
visualization settings files are located in the model's \attributes folder, and
they have the file name extension .4d.

1. In the model's \attributes folder, select the visualization settings you
want to copy.

2. Select where you want to copy the settings. 

• To make the settings available in another model, copy them to the
\attributes folder of the destination model.

• To make the settings available in all models, copy them to the project
or firm folder, defined by the advanced option XS_PROJECT or 
XS_FIRM.

3. Include a copy of the object representation settings file (.rep) and object
group files (.PObjGrp) in the \attributes, project, and firm folders to
ensure that all the files will work correctly.

4. Restart Tekla Structures.

7.3 Delete visualization settings
Delete the project status visualization settings that have been created using
the Project Status Visualization tool.

1. Delete the visualization settings file located in the model’s \attributes
folder. 

Project status visualization settings have the file name extension .4d.

2. Restart Tekla Structures.

7.4 Project status visualization example: Visualize the
erection schedule of a project
This example shows how to visualize erection schedules using the Project
Status Visualization tool.

1. Define an erection schedule for parts using the Planned start user-
defined attribute.

a. Double-click a part to open the part properties in the property pane.

b. Click UDAs.
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c. On the Workflow tab, modify the value of the Planned start user-
defined attribute in the Erection section. 

d. Select the Planned start check box.

e. Ensure that all other check boxes are cleared.

f. Select all the parts for which you want to use the same erection date. 

TIP To make it easier to select parts, create a separate selection
filter for each group of parts.

g. Click Modify.

h. Repeat the steps for each group of parts in your model. 

You can use a different erection date for each group of parts.

2. Select objects for the visualization by creating an object group that defines
which objects are shown in the model during the visualization.

a. On the View tab, click Representation to open the Object
Representation dialog box.

b. Click Object group... to open the Object Group - Representation
dialog box.

c. Create an object group that includes all objects whose Planned start
user-defined attribute is earlier than or equal to the review date. 

Define the following settings:

• In the Category list, select Object.

• In the Property list, select PLANNED_START_E.

• In the Condition list, select Earlier than or equal.

• In the Value list, select Select date....

• In the Select Date dialog box, select Review date and click OK.

d. In the box next to the Save as button, enter a name for the group. For
example, plan_same_or_before_review_date.

e. Click Save as. 

3. Define the color and transparency of the selected objects using color and
transparency settings that define how the objects are shown during the
visualization.
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a. On the View tab, click Representation to open the Object
Representation dialog box.

b. Define color and transparency settings for the object group that you
created in step 2: 

• Click Add row.

• In the Object group list, select the object group you just created.

• In the Color list, select Color by class.

• In the Transparency list, select Visible.

c. Define another set of color and transparency settings to hide the rest
of the parts from the model: 

• Click Add row.

• In the Object group list, select the object group All.

• In the Color list, select Color by class.

• In the Transparency list, select Hidden.

d. In the box next to the Save as button, enter a name for the settings.
For example, planned_start_erection_date.

e. Click Save as. 

4. Define a time period for the visualization.

a. On the Manage tab, click Project status to open the Project Status
Visualization dialog box.

b. Define the length of the time step.

c. Define a start and end date for the time scale slider.

d. In the Object representation list, select the object representation
setting you created in step 3.

e. Select the Refresh view automatically check box.

f. In the box next to the Save as button, enter a name for the
visualization.

g. Click Save as to save the visualization settings. 
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5. View the erection schedule using the Project Status Visualization tool.

a. On the Manage tab, click Project status to open the Project Status
Visualization dialog box.

b. In the list next to the Load button, select the visualization setting you
created in step 4.

c. Click Load.

d. To view the visualization in the model, click the step buttons. 

The images below show how the objects are shown when you change
the review date:

Review date Visualization

November 02
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Review date Visualization

November 05

November 08

November 11
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Review date Visualization

November 14

November 17
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Review date Visualization

November 20
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8 Reports

You can create reports of the information included in Tekla Structures models.
Reports can be lists of drawings, bolts, and parts, for example. Tekla Structures
creates reports directly from the model database, so the information is always
accurate. Reports can contain information about selected parts or the entire
model.

Tekla Structures includes a large number of standard report templates. Use
Template Editor to modify the existing report templates, or create new ones to
suit your needs.

Note that the reports do not get updated automatically when the model
changes, you need to recreate the reports.

The report templates are by default located in the system folders defined for
the advanced option XS_SYSTEM. Report templates have the file name
extension .rpt.
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Example

For more information about using Template Editor, see Template Editor Help.
To open the help, open Template Editor and click Help --> Contents . Here you
can find a link to the Template Editor User's Guide in the PDF format: Tekla
Structures PDF documentation.

See also

Create a report (page 177)

Show an existing report (page 180)

Print a report (page 181)

Tips for reports and report templates (page 183)

8.1 Create a report
You can include in a report information related to an entire model or only the
selected model objects. Tekla Structures automatically selects the related
assemblies and other objects. You can also create a report of several drawings
that include the desired model objects. Furthermore, you can produce a list of
assemblies, or a report of the parts included in the assemblies. If the report
template has a nested assembly structure, Tekla Structures displays the
assembly hierarchy in the report when you view or print it.

You can create reports in several formats, such as .xsr, .html, .csv, and PDF.
You can have Tekla Structures open all .html reports in a web browser. By
default, all reports are displayed in a new dialog box within the Tekla
Structures window.
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Create a report of entire model or selected objects
1. Open the model.

2. If needed, number the model. 

You can create reports without numbering the model. This is useful when
you need to produce draft reports from large multi-user models. Tekla
Structures still warns you if numbering is not up to date.

3. On the Drawings & reports tab, click Reports .

4. Define the viewing settings on the Options tab, or load the settings that
contain the desired viewing settings. You can select whether to view the
report in a dialog box or in an associated viewer, and also whether to
show the report after creation or not.

We recommend that you set the viewing options to the ones that you use
the most often and save the settings in the stardard settings file by
clicking the Save button at the top. You can also save the settings to
another file by using Save as.

5. Select a report template from the Report templates list. When you select
a template, you can see the name of the template and the template
format in the Report file box.

6. Enter the report titles you want to use in the Titles in reports lists.

7. You can change the report file name in the Name box.

8. Unless you want to create a report of the entire model, select the objects
you want to include in the report using appropriate selection switches and
filters.

9. Do one of the following: 

• To run a report on the entire model, click Create from all.

• To run a report on the selected model objects, click Create from
selected.

Tekla Structures creates the report according the settings you defined, and
shows the report if you have selected to show it.

Create a report of selected drawings
1. Create drawings of the parts you want to include in the report.

2. Open the model.

3. On the Drawings & reports tab, click Document manager.

4. In Document manager, select the drawings you want to include in the
report. 
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TIP To select multiple drawings, hold down Ctrl and then click the
drawings you want to select.

5. On the Drawings & reports tab, click Reports.

6. Select a drawing report template from the list. 

For example, select Drawing_List or Drawing_Revision_History.

7. Enter the report titles you want to use in the Titles in reports lists.

8. You can change the report file name in the Name box.

9. Go to the Options tab and set the viewing options. You can select whether
to view the report in a dialog box or in a viewer, and also whether to show
the report immediately after creation or not.

10. Click Create from selected. 

Tekla Structures automatically selects all the parts in the selected
drawings and includes them in the report, creates the report according
the settings you defined, and shows the report if you have selected to
show it.

Create a report of nested assemblies
1. Open the model.

2. Select the assemblies you want to include in the report.

3. On the Drawings & reports tab, click Reports.

4. Select an assembly report template from the list. 

The following reports can be found in the default environment.

• Assembly_List: Creates a list of the assemblies

• Assembly_Part_List: Creates a report of the parts included in the
assemblies

5. Enter the report titles you want to use in the Titles in reports lists.

6. You can change the report file name in the Name box.

7. Go to the Options tab and set the viewing options. You can select whether
to view the report in a dialog box or in an associated viewer, and also
whether to show the report or not.

8. Click Create from selected.

Tekla Structures creates the report according the settings you defined and
shows the report if you have selected to show it.
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Report settings

Setting Description
Report templates Lists all the available report

templates.
Titles in reports Optional report titles.

You can enter up to three report
titles. All titles are not used in every
standard report. Title1, for example,
is used to show phase information in
the Assembly_list report.

Browse Use to change the folder where the
report will be stored. By default,
reports are stored in the current
model folder.

Show Shows the selected report.
Print Prints the selected report.
Create from all Creates a report from all objects in

the model using the selected
template.

Create from selected Creates a report from the objects you
have selected using the selected
template.

Options: Show report Defines how Tekla Structures displays
reports.

On dialog displays the report in a
new window.

With associated viewer displays the
report in the associated program. For
example, you can have Tekla
Structures open all HTML reports in a
web browser.

Options: Show created report Defines whether or not the report is
automatically shown on the screen
after it has been created.

8.2 Show an existing report
You can show in a separate window reports that you have created of the
current model.

1. On the Drawings & reports tab, click Reports.
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2. Define the viewing settings on the Options tab, or load the settings that
contain the desired viewing settings. You can select whether to view the
report in a dialog box or in an associated viewer, and also whether to
show the report after creation or not.

We recommend that you set the viewing options to the ones that you use
the most often and save the settings in the stardard settings file by
clicking the Save button at the top. You can also save the settings to
another file by using Save as.

3. Click Browse to locate the report file you want to view, select the file and
click OK.

4. Click Show to view the report the dialog box or in an associated viewer
according to you selection. 

When you click an object ID row, the corresponding object is highlighted in
the model.

Useful shortcuts for viewing reports

To Do this
Zoom to the objects selected in a
report

1. Hold down Z.

2. Click a row that contains an ID
number.

Tekla Structures zooms to the
corresponding objects in the
active model view.

Fit the work area to include only the
objects selected in a report

1. Hold down F.

2. Click a row that contains an ID
number.

Tekla Structures zooms to the
corresponding objects in the
active model view.

See also

Create a report (page 177)

8.3 Print a report
You can print a report from the Reports dialog box or through the File menu.

1. Do one of the following: 

• On the Drawings & reports tab, click Reports, and then click Print

• On the File menu, click Printing --> Print reports .
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2. Use the Browse button to display the Select file dialog box, where you
can browse to the desired folder and select the report. 

By default, Tekla Structures uses the Report files (*.xsr) filter to show
Tekla Structures *.xsr reports only. To show all file types, change the
filter to All files (*.*).

3. If needed, modify the print settings: 

• To change the report font and font style, click Select.

In the displayed dialog box, you can only change the font and font
style, the font size is fixed to 12. One way to change the font size is to
open the created report in a text editor and change the font size there.
The default font can be changed with the advanced option 
XS_PRINT_REPORT_FONT.

• To set printer-specific options such as paper size and orientation, click
Printer setup.

4. Click Print. The report is printed.

Embed fonts in PDf reports

The PDF report options are read from a settings file with the name
report.PdfPrintOptions.xml. This allows the embed fonts option to be
enabled for languages that require it. This file is not included by default in
environments, but some environments might include it. If no such files are
present, the default hard coded options are used.

The settings file can be present in any location where PdfPrintOptions.xml
files are normally searched for. For more information about printing settings
and file locations, see Printing settings files and search order.

To embed fonts, open the report.PdfPrintOptions.xml file in a text
editor, for example Microsoft Notepad, and change <EmbedFonts>false</
EmbedFonts> to <EmbedFonts>true</EmbedFonts>. Save the file in the
environment folder where you found it, or in the current model folder, or in
any of the folders defined by the XS_SYSTEM advanced option, for example.

<?xml version="1.0" encoding="utf-8"?>
<PdfPrintOptions Version="1.3">
  <Options>
    <PrintTarget>PDF</PrintTarget>
    <PrinterName>Microsoft Print to PDF</PrinterName>
    <PDFAndPlotFileLocation>.\Plotfiles</PDFAndPlotFileLocation>
    <EmbedFonts>true</EmbedFonts>
    <OpenFolderWhenFinished>false</OpenFolderWhenFinished>
    <OpenFileWhenFinished>false</OpenFileWhenFinished>
    <OutputToSingleFile>false</OutputToSingleFile>
    <SinglePDFFileName>combined</SinglePDFFileName>
    <PlotFileExtension>plt</PlotFileExtension>
    <PlotFilePrefix />
    <PlotFileSuffix />
    <ScalingMethod>Scale</ScalingMethod>
    <ScaleFactor>1</ScaleFactor>
    <CenterDrawingOnPaper>true</CenterDrawingOnPaper>
    <PrintOnMultipleSheets>false</PrintOnMultipleSheets>
    <MultipleSheetOrder>LeftToRightTopToBottom</MultipleSheetOrder>
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    <PaperSize>Letter (8 1/2x11)</PaperSize>
    <Orientation>Auto</Orientation>
    <ColorMode>Color</ColorMode>
    <NumberOfCopies>1</NumberOfCopies>
    <Collate>false</Collate>
    <IncludeRevision>false</IncludeRevision>
    <LineThicknesses>
      <LineThickness Color="151" Pen="0" />
      <LineThickness Color="150" Pen="0" />
      <LineThickness Color="0" Pen="0" />
      <LineThickness Color="152" Pen="1" />
      <LineThickness Color="153" Pen="0" />
      <LineThickness Color="160" Pen="0" />
      <LineThickness Color="161" Pen="0" />
      <LineThickness Color="162" Pen="0" />
      <LineThickness Color="163" Pen="0" />
      <LineThickness Color="164" Pen="0" />
      <LineThickness Color="165" Pen="0" />
      <LineThickness Color="154" Pen="0" />
      <LineThickness Color="155" Pen="0" />
      <LineThickness Color="156" Pen="0" />
      <LineThickness Color="157" Pen="0" />
      <LineThickness Color="158" Pen="0" />
      <LineThickness Color="159" Pen="0" />
      <LineThickness Color="130" Pen="0" />
      <LineThickness Color="131" Pen="0" />
      <LineThickness Color="132" Pen="0" />
      <LineThickness Color="133" Pen="0" />
      <LineThickness Color="9" Pen="1" />
      <LineThickness Color="15" Pen="1" />
    </LineThicknesses>
    <PlotColors>
      <PlotColor Color="151" PlotColor="000000" />
      <PlotColor Color="150" PlotColor="FEFEFB" />
      <PlotColor Color="0" PlotColor="000000" />
      <PlotColor Color="152" PlotColor="E7E7E7" />
      <PlotColor Color="153" PlotColor="000000" />
      <PlotColor Color="160" PlotColor="FE0000" />
      <PlotColor Color="161" PlotColor="00E700" />
      <PlotColor Color="162" PlotColor="0000FE" />
      <PlotColor Color="163" PlotColor="00FEFE" />
      <PlotColor Color="164" PlotColor="FFFF00" />
      <PlotColor Color="165" PlotColor="FE00FE" />
      <PlotColor Color="154" PlotColor="7F3F3F" />
      <PlotColor Color="155" PlotColor="008000" />
      <PlotColor Color="156" PlotColor="323298" />
      <PlotColor Color="157" PlotColor="007F7F" />
      <PlotColor Color="158" PlotColor="FE6500" />
      <PlotColor Color="159" PlotColor="959595" />
      <PlotColor Color="130" PlotColor="4C4C4C" />
      <PlotColor Color="131" PlotColor="7F7F7F" />
      <PlotColor Color="132" PlotColor="B2B2B2" />
      <PlotColor Color="133" PlotColor="E5E5E5" />
      <PlotColor Color="9" PlotColor="D8D8D8" />
      <PlotColor Color="15" PlotColor="7F7F7F" />
    </PlotColors>
  </Options>
  <PreviewMinimumPenWidth>0.5</PreviewMinimumPenWidth>
</PdfPrintOptions>
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8.4 Tips for reports and report templates
There are some things that you might consider to be able to create reports
more efficiently.

Select objects to include in a report using GUIDs
You can select objects to be included in reports by using their GUIDs (globally
unique identifiers).

1. In Template Editor, create a template that is used for creating the report:

a. In Tekla Structures, on the File menu, click Editors --> Template
Editor .

b. In Template Editor, click File --> New .

c. Select Textual template and click OK.

d. Add a row for the GUID. 

• Click Insert --> Component --> Row .

Select a content type for the row and clicking OK.

• Click Insert --> Text and enter the text guid:, Guid: or GUID:.
Click OK.

This enables the selecting of objects in the model.

• Click Insert --> Value Field . Click a point to define the location of
the field within the row. The Select Attribute dialog box appears
prompting you to select an attribute for the value field.

Select the attribute GUID and click OK.

e. Add the required amount of other rows in the template.

f. Click File --> Save As . 

Enter a name for the template and browse to the folder that has been
defined templates for the advanced option XS_TEMPLATE_
DIRECTORY. Use the file name extension .rpt.

2. Create a report based on the report template you saved.

a. On the Drawings & reports tab, click Reports.

b. Select the report template you created from the list.

c. Click Create from all. 

Tekla Structures displays the report.

3. Click a row that contains an GUID number in the report. 

Tekla Structures selects the corresponding object in the active model view.
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Show report content in correct cells
You can associate Tekla Structures to open reports of a certain type in
Microsoft Excel. When you open such reports in Microsoft Excel, the report
template rows might not be divided correctly into cells. To correct this, you can
add tabs between the cells.

1. Open an existing report template in Template Editor.

2. Add \t between the text and value fields. For example: 

3. Save the report. 

The output in Microsoft Excel:

The output in a text editor:
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TIP Alternatively, you can use a comma or semicolon as a delimiter between the text
fields. However, the default delimeter may vary between users, and the output
might not be readable in all text editors.
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9 Disclaimer

© 2023 Trimble Solutions Corporation and its licensors. All rights reserved.

This Software Manual has been developed for use with the referenced
Software. Use of the Software, and use of this Software Manual are governed
by a License Agreement. Among other provisions, the License Agreement sets
certain warranties for the Software and this Manual, disclaims other
warranties, limits recoverable damages, defines permitted uses of the
Software, and determines whether you are an authorized user of the Software.
All information set forth in this manual is provided with the warranty set forth
in the License Agreement. Please refer to the License Agreement for important
obligations and applicable limitations and restrictions on your rights. Trimble
does not guarantee that the text is free of technical inaccuracies or
typographical errors. Trimble reserves the right to make changes and
additions to this manual due to changes in the software or otherwise.

In addition, this Software Manual is protected by copyright law and by
international treaties. Unauthorized reproduction, display, modification, or
distribution of this Manual, or any portion of it, may result in severe civil and
criminal penalties, and will be prosecuted to the full extent permitted by law.

Tekla Structures, Tekla Model Sharing, Tekla PowerFab, Tekla Structural
Designer, Tekla Tedds, Tekla Civil, Tekla Campus, Tekla Downloads, Tekla User
Assistance, Tekla Discussion Forum, Tekla Warehouse and Tekla Developer
Center are either registered trademarks or trademarks of Trimble Solutions
Corporation in the European Union, the United States, and/or other countries.
More about Trimble Solutions trademarks: http://www.tekla.com/tekla-
trademarks. Trimble is a registered trademark or trademark of Trimble Inc. in
the European Union, in the United States and/or other countries. More about
Trimble trademarks: http://www.trimble.com/trademarks.aspx. Other product
and company names mentioned in this Manual are or may be trademarks of
their respective owners. By referring to a third-party product or brand, Trimble
does not intend to suggest an affiliation with or endorsement by such third
party and disclaims any such affiliation or endorsement, except where
otherwise expressly stated.

Portions of this software:

EPM toolkit © 1995-2006 Jotne EPM Technology a.s., Oslo, Norway. All rights
reserved.
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Portions of this software make use of Open CASCADE Technology software.
Open Cascade Express Mesh Copyright © 2019 OPEN CASCADE S.A.S. All rights
reserved.

PolyBoolean C++ Library © 2001-2012 Complex A5 Co. Ltd. All rights reserved.

FLY SDK - CAD SDK © 2012 VisualIntegrity™. All rights reserved.

This application incorporates Open Design Alliance software pursuant to a
license agreement with Open Design Alliance. Open Design Alliance Copyright
© 2002-2020 by Open Design Alliance. All rights reserved.

CADhatch.com © 2017. All rights reserved.

FlexNet Publisher © 2016 Flexera Software LLC. All rights reserved.

This product contains proprietary and confidential technology, information
and creative works owned by Flexera Software LLC and its licensors, if any. Any
use, copying, publication, distribution, display, modification, or transmission of
such technology in whole or in part in any form or by any means without the
prior express written permission of Flexera Software LLC is strictly prohibited.
Except where expressly provided by Flexera Software LLC in writing,
possession of this technology shall not be construed to confer any license or
rights under any Flexera Software LLC intellectual property rights, whether by
estoppel, implication, or otherwise.

To see the third party open source software licenses, go to Tekla Structures,
click File menu --> Help --> About Tekla Structures --> 3rd party licenses
and then click the option.

The elements of the software described in this Manual are protected by
several patents and possibly pending patent applications in the United States
and/or other countries. For more information, go to page http://
www.tekla.com/tekla-patents.

Disclaimer 188

http://www.tekla.com/tekla-patents
http://www.tekla.com/tekla-patents


Index

4
4D tool, see visualizing project status...... 168

A
assemblies

lotting......................................................162
reports....................................................177

C
cast units

lotting......................................................162
creating

reports....................................................177
reports of nested assemblies.............. 177
reports of selected drawings............... 177

custom phases............................................ 159

D
dividing models...........................................159
drawings

reports....................................................177

E
erection sequences.....................................159

F
fonts

reports....................................................181

L
locking

model objects by phase....................... 159
log files

viewing....................................................183
lotting........................................................... 162

M
models

dividing into phases..............................159

N
nested assemblies

reports....................................................177
numbering

sequences.............................................. 165

O
Organizer..........................................................7

calculating property values.................... 18
categories.................................................35
classification code.................................111
creating categories.............37,42,43,47,50
creating color sets................................... 32
creating custom formulas...................... 30
creating custom properties....................28
creating property templates.................. 24
creating subcategories........................... 50
customizing..............................................57
deleting categories..................................57
deleting property templates.................. 33
example of creating categories............. 68
example of creating categories for
architectural design.............................. 118

189



example of creating categories for
structural design................................... 117
example of Organizer workflow....
68,117,118,121,123,124
example of reporting areas.............. 88,96
example of reporting project status..... 96
example of tracking object properties..81
example of using Organizer for precast
.................................................................124
example of using Organizer to manage
assemblies............................................. 123
example of using Organizer to manage
bolts........................................................ 121
excluding objects.....................................59
export to IFC.......................................... 111
exporting categories............................... 64
exporting object properties................... 20
exporting property templates............... 34
grouping object properties.................... 15
importing categories...............................66
importing IFC categories........................ 67
importing property templates............... 33
missing objects........................................ 59
Model Organizer categories...................67
modifying categories.............................. 52
multi-user mode......................................68
refresh...................................................... 60
reload........................................................60
reporting...................................................63
setting units............................................. 19
setting up................................................. 57
synchronize..............................................60
update database..................................... 60
viewing object properties......................... 8

P
parts

sequences.............................................. 165
phases.......................................................... 159
printing

reports....................................................181
project status visualizations...................... 168

R
reports..........................................................176

adding tabs............................................ 183
creating...................................................177
drafts...................................................... 177
entire model.......................................... 177
fonts........................................................181
nested assemblies................................ 177
printing................................................... 181
selected drawings................................. 177
selected model objects.........................177
selecting included objects....................184

settings............................................. 177
titles.................................................. 177

tips.......................................................... 183
titles in reports...................................... 177
useful shortcuts in viewing logs and
reports....................................................183
viewing............................................ 180,183

S
selecting

objects included in reports.................. 184
sequences

user-defined attributes........................ 165
settings

reports....................................................177
shortcuts

in viewing logs and reports..................183

T
tabs

in reports................................................183
Task Manager.............................................. 134

add objects to tasks.............................. 138
creating tasks.........................................138
dependencies........................................ 138
export..................................................... 153
filtering tasks......................................... 150
Gantt chart.............................................134
import.....................................................153
link tasks to model................................138
printing................................................... 155
schedule................................................. 138
task properties...................................... 138
track objects...........................................138
track schedule....................................... 138

190



user interface.........................................134
user-defined attributes........................ 138
viewing tasks..........................................150
visualizing schedule.............................. 156

Template Editor...........................................176
templates

tips.......................................................... 183
tips

templates and reports..........................183

U
unlocking

model objects by phase....................... 159
user-defined attributes

sequences.............................................. 165

V
viewing

reports....................................................180

191



192


	Contents
	1 Organizer
	1.1 View object properties in Organizer
	View the objects selected in the model or the objects of a category
	Set the limit for the number of objects shown in Object Browser
	View another property template
	Set the default property template
	Pin the current template in Object Browser
	Group object properties
	Show assembly content
	Combine identical rows
	Show calculated results of object property values in the sum row
	Use colors to visualize Object Browser groups in the model
	View categories, and unions and intersections of categories
	List the categories of objects
	Hold the current view in Object Browser and remove objects and categories from the view
	Select the command buttons shown in Object Browser
	Change the order of columns
	Change the sorting direction
	Group object properties in Organizer
	Calculate property values in Organizer
	Set the units in Organizer

	1.2 Report object property values from Organizer
	1.3 Create a property template in Organizer
	Create a custom property in Organizer
	Create a custom formula in Organizer
	Create a color set in Organizer
	Delete a property template in Organizer

	1.4 Import a property template to Organizer
	1.5 Export a property template from Organizer
	1.6 Categories in Organizer
	Create location categories in Organizer
	Create location categories manually in Organizer
	Create a property category in Organizer
	Create a custom category in Organizer
	Create automated subcategories in Organizer
	Modify a category in Organizer
	Delete a category in Organizer
	Customized default setup for Organizer
	Excluding object types from Organizer

	1.7 Synchronize Organizer with the model
	Synchronize Organizer
	Update the whole Organizer database
	Reload Object Browser
	Synchronize a category

	1.8 Report Organizer location categories
	1.9 Export a category from Organizer
	1.10 Import a category to Organizer
	Categories created in earlier Tekla Structures versions

	1.11 Import IFC categories to Organizer
	1.12 Organizer in the multi-user mode
	1.13 Example: Organize the model into location and custom categories, and view quantities
	Example: Organize the model to buildings, sections and floors
	Example: Create a custom category with automated subcategories based on object names in Organizer
	Example: Create a custom category for reinforcing bars in Organizer
	Example: Create a concrete quantity take-off using Organizer
	Example: Create a reinforcing bar quantity take-off using Organizer

	1.14 Example: Track modeling and planning issues using Organizer
	Example: Track reinforcing bar length using Organizer
	Example: Track too heavy precast elements from a reference model using Organizer
	Example: Create weight group categories to track different weights using Organizer
	Example: Track large concrete volumes using Organizer

	1.15 Example: Report areas based on object groups in Organizer
	1.16 Example: Calculate and report areas based on object type and project status in Organizer
	1.17 Example: Add a classification code to objects in Organizer and export the code to IFC
	1.18 Example: Create a custom category for structural design status in Organizer
	1.19 Example: Create a custom category for architectural design status in Organizer
	1.20 Example: Organizer for steel - manage bolts
	1.21 Example: Organizer for steel - manage assemblies
	1.22 Example: Organizer for precast

	2 Building hierarchy
	2.1 How to use the
            Building hierarchy dialog box
	2.2 Import levels
            and spaces from a reference model
	2.3 Create
            levels
	2.4 Create
            spaces
	2.5 Manage levels and spaces
	2.6 Create views on selected levels
	2.7 Example:
            Building hierarchy in Organizer

	3  Task Manager 
	3.1 Task manager user interface
	Modify your Task manager view
	Modify the calendar in Task manager

	3.2 Create a task in Task manager
	Link a task to the model
	Define a task type
	Define a contractor in Task manager
	Define general task properties
	Define a task schedule
	Manage the planned dates of objects in a task
	Track a task schedule
	Define the order of objects in a task
	Define a dependency between tasks
	Define additional information for a task
	Create a scenario

	3.3 View and filter tasks in Task manager
	3.4 Import and export tasks and task types in Task manager
	Import tasks and task types
	Export tasks and task types

	3.5 Print a task schedule from Task manager
	3.6 Example: Visualize a Task manager schedule in the model

	4 Phase Manager
	4.1 Divide the model into phases
	4.2 Lock and unlock objects in specific phases
	4.3 Define custom phase properties

	5 Lotting
	5.1 Create a lot
	5.2 Add parts to a lot
	5.3 Remove parts from a lot
	5.4 Delete a lot

	6 Sequencer
	6.1 Create a sequence
	6.2 Add parts to a sequence
	6.3 Check the sequence of a part
	6.4 Modify the sequence number of a part
	6.5 Delete a sequence

	7 Project status visualization
	7.1 Create a visualization
	7.2 Copy visualization settings to another model
	7.3 Delete visualization settings
	7.4 Project status visualization example: Visualize the erection schedule of a project

	8 Reports
	8.1 Create a report
	Create a report of entire model or selected objects
	Create a report of selected drawings
	Create a report of nested assemblies
	Report settings

	8.2 Show an existing report 
	8.3 Print a report 
	8.4 Tips for reports and report templates
	Select objects to include in a report using GUIDs
	Show report content in correct cells


	9 Disclaimer
	Index

